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 Introduction

Welcome
Thank you for choosing iWorx LabScribe Data Recording and Analysis Software. Developed 

over a 5-year period, LabScribe software is the result of more than seventy man years of 
collective experience in data recording. We are confident that this software will make your data 
recording and analysis easier and welcome suggestions for improving our products. Please 
contact us with comments, concerns or suggestions at 800-234-1757 or via e-mail at: 
support@iworx.com. 

How to Use This User’s Guide
This User’s Guide assumes you know how to operate your computer and are familiar with 

basic Windows terminology. The Table of Contents lists each chapter and its contents. You can 
use it or the index to locate pages on a particular subject. The Appendix provides some useful 
reference materials.

We have divided the subject matter into categories and explained each in detail, but if you’d 
rather cut to the chase, The Quick Start chapter should have you recording data in less than an 
hour.

System Requirements
LabScribe recording software requires a Pentium II-level computer running Windows 98, 

Windows ME, Windows 2000, or Windows XP with at least 128 megabytes of RAM and at least 
50 megabytes of free space on your hard drive. 

The preferred processor is a Pentium III or Pentium 4 with AGP graphics card, 256 megabytes 
of RAM running Windows 98/Me or Windows 2K/XP. The minimum recommended system config-
uration is a Pentium II, 300 megahertz computer. The faster the processor, the smoother the 
screen scrolling, however, all data is recorded regardless of the screen scrolling display.

Installation

From CD LabScribe software is provided on a CDROM. If you don’t have a CD drive, the software 
installer can be downloaded from our FTP area. Point your browser to http:/www.iworx.com., 
select Support from the directory, and sign up for the iWorx Users’ Area. All installers are 
available at the Users’ Area.

WARNING: Do not connect your iWorx hardware to the computer until AFTER the software 
installation is complete.

To install the software using the CDROM:

1 Insert the LabScribe installation CD. 
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2 A welcome screen will appear offering to install Software, Hardware, or Manuals.

3 Choose Software, then choose the Windows operating system currently in use (XP, 98, 2000, ME). At 
the prompt enter your name, the name of your company or institution, and software serial number (on 
the CD cover). Click Next. It is important to note that the software will not install without a proper serial 
number. Installation will now proceed. Follow the instructions presented by the Install Wizard. The 
Install Wizard will tell you when the installation is complete. The installer will restart your computer once 
the software installation is complete

4 After installing the LabScribe software, you can install lab manuals associated with various kits by 
clicking the Manuals button. You must install the LabScribe program before you can install the 
laboratory manuals

5 You can also install Adobe Acrobat Reader, which is required to view .pdf versions of the lab experi-
ments.

6 Remove the installation CD from the drive, connect and turn on your iWorx Hardware.

Note: When your hardware is connected for the first time, Windows will advise you “New Hardware found” 
and proceed to load the driver automatically. If for some reason Windows cannot locate the driver. Point the 
install wizard to the iWorx/LabScribe/drivers folder in the Program Files folder.

From User’s 
Area

To install using the downloaded installer from our FTP site:

1 Go the Users’ Area on the iworx.com website. Select the proper installer for the Windows operating 
system on your computer. After downloading the LabScribe software installer, double click on the 
downloaded file. It is a self extracting archive, which will automatically launch the installer after it 
extracts. (Files are normally stored in the Windows Temp Folder). The installer will then open the 
Install Wizard and walk you through the installation.

2 Go to step 3 above.

Registration and Updates
Be sure to register on-line at our website at: http://www.iworx.com. Registering your software 

ensures that you are notified of updates, new releases, send the free upgrades you are entitled 
to for as long as you use the program. Software and .pdf manuals are available from the 
password protected area of our website. Passwords are available to registered users only by 
submitting an e-mail request.

Comments and Suggestions
iWorx/CB Sciences understands that user feedback is critical to the improvement of any 

software product. If you have ideas, suggestions or criticisms, please contact us at: 
support@iworx.com.
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Technical Support
If you cannot find an answer in this User’s Guide, please check the list of FAQ’s (Frequently 

Asked Questions) on our website. If you still cannot find a solution to your problem, technical 
support is available to all registered users at no charge via e-mail, phone, fax or mail. When 
requesting technical support, please follow the steps listed below:

• Write down your question or problem and the actions you took that created the problem.

• Be prepared to duplicate the problem.

• Note any error messages.

• Note your computer model.

• Note your operating system version.

• Note the amount of RAM (Random Access Memory) in your computer.

• Note your LabScribe Software version number.

See the sample customer support form in the appendix of this manual.

Contacting iWorx/CB Sciences
iWorx/CB Sciences, Inc.

One Washington Center, Suite 404

Dover, NH 03820 USA

For Sales: Phone: 800-234-1757 (Outside North America: 603-742-2492)

FAX: 603-742-2455

E-mail: sales@iworx.com

Web: http://www.iworx.com

For Technical 
Support

Phone: 877-273-7110 (Outside North America: 603-742-2492)

FAX: 603-742-2455

E-mail: support@iworx.com

Web: http://www.iworx.com
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Chapter 1: Quick Start
Start here if you are already familiar with data recording concepts. This chapter contains all 

you need to know to begin recording data quickly and easily.

Managing Signals
The management of recorded data is divided into three steps:

1 Recording data onto the computer,

2 Navigating the recorded data to find particular areas of interest, and

3 Outputting the data either in printed or analyzed form.

Recording 
Data

Recording data is the most basic of the three steps. It is also the only one that is time critical. 
That is, you must record data when it happens, whereas navigating, analyzing or printing data 
can occur anytime after the data has been recorded. The following section explains the basic 
concepts and controls required to record data using the LabScribe software.

Start Recording The most basic control in the LabScribe software is the one that starts and stops the 
recording. This control is found in the upper right hand corner of the Main window. After 
ensuring that the source of your signal is properly connected to your data acquisition device, 
click the Start button to begin recording. While data is being recorded the Start button will 
change to a Stop button. Click Stop at any time to end data recording.

Displaying Data The events you want to record using the LabScribe software may be very slow, like the 
discharge curve of a 9-Volt transistor battery, which can take hours; or very fast, like the QRS 
complex in a human electrocardiogram, which may take only a fraction of a second. LabScribe 
software allows you to record both slow and fast events, while displaying the recorded results in 
a format that is easily interpreted. To manage the temporal display of your data in the LabScribe 
software, a parameter called screen time is used. 

1 Screen time is simply the amount of time represented by one full screen of data. When the program 
opens, the default screen time is set to 10 seconds. You can change the screen time by using the Half 
or Double Display Time controls in the toolbar (Figure 1-1 on page 4).

 Figure 1-1: The Display Time icons 
on the LabScribe Main window 
toolbar.
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• Clicking the Half Display Time button (big mountain) “halves” the screen time. So, a 10-second, full-
screen display becomes a five-second, full-screen display, effectively doubling the display resolution. 

• Clicking the Double Display Time button (little mountain) doubles the screen time. Therefore, a 10-
second, full-screen display becomes a 20-second, full-screen display allowing twice as much data to be 
displayed on one screen.

2 To manage the vertical display on the data on the y-axis of the window, the LabScribe software uses an 
AutoScale feature. The AutoScale function examines the recorded data in the current screen and 
adjusts the display so that the data is centered along the y-axis, and the amplitude is adjusted to allow 
the best possible view of all of the data.The AutoScale button is located on the channel bar of each 
data channel. 

• Clicking the AutoScale button resizes the data and centers it on the current screen. The AutoScale 
button can be used as frequently as needed. 

• Clicking the AutoScale button, when large artifact spikes are present on the screen, will result in a 
smaller than optimal display of real data since the AutoScale function sets the highest and lowest data 
points close to the upper and lower limits of the screen.

3 The value display box also appears on the channel bar above the channel window. The amplitude 
value of the data at the position of the cursor or the value of the data point that is currently being 
recorded is displayed in the box, in the units you specified. If you are using Dual Cursor Mode, the 
difference between the amplitudes at Cursor 1 and Cursor 2 will be displayed. 

4 To the right of the value display box, you will see a red triangle which is used to move the channel bar 
up and down, Moving the triangle changes the size of the channel window and the amount of space 
allocated to the adjacent channels.

 Figure 1-2: The common controls of each channel in the LabScribe Main window.

Controls The main controls for the LabScribe program are located in the Preferences dialogue 
windows in the Edit Menu. Controls are also found on the right-click menu of each channel. 
The Preferences dialogue pages are used to control basic program parameters, such as the 
outputs, sample speed, and recording mode. The right-click menu is generally used to manip-
ulate the raw data through online functions, such as transformations that convert the raw data to 
rates, integrals, derivatives, and more.

The Preferences 
Dialogue Pages

From the Preferences dialogue pages, parameters controlling the Channels, Sampling, 
Stimulator(s), computed Functions, and Output Sequences can be set. For example, the 
number of channels to be displayed in the Main window and their titles, the sampling rate, and 
the display width of the screen can be set from this dialogue window. Many more parameters, 
some explained in other sections of this manual, can be set from the Preferences pages. These 
parameters can also be saved as a settings file, to be used again and again to perform the 
same experiment. The creation of groups of settings and the actual settings themselves is 
accomplished through the functions of the Settings Menu.
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The Channel 
Right-Click 
Menu

From the channel right-click menu, some of the parameters also controlled in the Prefer-
ences dialogue pages, can be set. These include Input Mode, Units, SetScale, and Title. 

More importantly, raw data can be transformed by computed functions and displayed as values 
which provide an easier interpretation of the data. For example, cyclic data, like that of an ECG, 
can be transformed by Rate function to a plot of the subject’s heart rate (BPM). Some of the 
functions available include: Frequency, Period, Integral, Derivative, Channel Math, 
Spirometry Volumes, and EEG Power Spectrum. By default, the source of raw data for the 
transformation is set to the channel above the computed function channel; but, the channel that 
is the source of the raw data can be specified through the Set Raw Ch function on the right-
click menu. 

Some other functions, like software-based Filters and Stimulator Displays, are also 
controlled from the right-click menu.

Saving Data Data recorded in a file can be saved, closed, and opened at a later time for analysis.

To save the recorded data in a file, select Save As in the File menu. Name the file in the file 
name box. Choose a destination on the computer in which to save the file (e.g. the iWorx or 
class folder). Click the Save button to save the file (as an *.iwd file). 

Navigating 
Data

Once recorded, data is “navigated” or moved through in a few ways:

Analysis Window An area of the data can be selected for viewing and measurement in the Analysis window. 

1 Use the screen time controls (Half or Double Display Time) to provide a better view of recorded 
events. Click on the Double Display Time button (little mountain in toolbar, Figure 1-1 on page 4) until 
all of the data is visible in a single screen.

2 Use the Dual Cursor button (button with two vertical lines in Figure 1-1 on page 4) in the toolbar. Two 
cursor lines appear on the Main window. Use the cursors to bracket areas of interest within the visible 
data. The selected area can then be expanded to full screen in the Analysis window.

 Figure 1-3: The Cursor icons on the 
LabScribe Main window toolbar.

3 Once the cursors are positioned, click the Analysis button in the toolbar. The area of data between the 
cursors will now be displayed full screen in the Analysis window. Other cursor uses are described in the 
Display section of this manual.

Marks Marks can also be used to navigate data. A Mark is a text annotation made while recording or 
after recording, that is locked to the data at a certain point in time. 

1 To mark the record while you are recording, use the keyboard to type a message on the Marks line. 
Pressing Return or Enter on the keyboard will enter the text mark on the recording at that time.
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2 When reviewing data, you can move directly to a mark from anywhere in the data using the Marks 
window. To open the Marks window, click on the Marks button in the toolbar or select Marks from the 
Window menu of LabScribe. Select the mark of interest. Click the GoTo button to move directly to the 
area of data that contains the mark.

3 Marks can be entered after data recording is complete using the Single Cursor button (the button with 
a single vertical line in Figure 1-1 on page 4). 

4 The text attached to a mark can be seen at the bottom of the screen, just above the timeline. Text marks 
can be dragged and dropped anywhere in the record. For example, a mark may denote that a drug was 
administered at a certain time. Using the mouse, you can click on the text associated with a mark and 
drag it to the channel to which it corresponds.

Scroll Bar Lastly, data can be navigated by using the scroll bar at the bottom of the Main window. Click 
on the right scroll arrow to move to the data on the right side of the screen. Click on the left 
scroll arrow to move to data on the left side.

Getting Data 
Out

Printing Data The most obvious method of exporting data is to print it. The Print command in the LabScribe 
software prints the window (Main, Analysis, ScopeView, Journal) in the foreground. 

To print the Main window, use the Display Time controls to adjust the amount of data on the 
screen. Pull down the File menu and select Print. Choose from the following print ranges that 
are available:

• All: Prints the complete file.

• Pages from___ to ___: Prints only the pages in the range selected.

• Selection: Prints only data visible in the window.

Copying and 
Pasting Data

Data can be exported using the Cut, Copy and Paste commands located in the Edit Menu of 
the program. 

The Copy command always looks at the window in the foreground. For instance, using the 
Copy command, while the Main window is in the foreground, copies the data in the Main 
window to the clipboard (as a picture). Adjusting the screen time affects what data will be 
included in the picture. Copying data is best done from the Analysis window; you have more 
control over which channels and time domain will be displayed and copied.

Exporting Data Select areas of data in the file can be saved for export.

• Select the area of data to be saved and exported using the Dual Cursor mode in the Main window.

• Click the Analysis button in the toolbar to view the selected data in the Analysis window.

• Open the File menu and select Export. A dialog box appears and provides for the naming and format of 
the file to be exported from the Analysis window. Files to be exported can be saved pictures (.bmp - 
bitmap and .png - portable network graphics formats are currently supported), text file (.txt - ASCII or 
.atf - Axon Text), as a MatLab file (.mat), or a DADiSP file (.dat).

• Complete data files can be saved, from the Main window, as a MatLab file or DADiSP file.
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Analysis Apart from the cursor measurements available in the LabScribe Main window, analysis occurs 
in two places. Data manipulation, close examination, and a variety of calculations are handled in 
the Analysis window. and wave to wave transforms are called from each channel’s right-click 
menu while viewing the Main window. For specific information on analyses that each of these 
categories can perform, refer to the chapter in this manual on Analysis. The basics are summa-
rized in this chapter.

On a given selection of data displayed in the Analysis window, the program can calculate and 
report the selected parameters. These are displayed across the top of the window in the Calcu-
lated Value Display area. By selecting the Send To Journal items in the Tools menu (or right-
click menu), these values for the selected parameters can be sent to a part of the LabScribe 
program called the Journal. 

Journal The Journal is an internal word processing application capable of accepting calculated 
numbers from the Analysis, FFT, or XY window as well as copied pictures from any window, In 
addition to values and pictures, text can be put into the Journal using the keyboard. This allows 
lab reports or explanatory documents to be composed without having to leave the LabScribe 
program. The Journal contents are saved to disk in the popular .rtf format, so that saved 
Journal documents can be imported and opened for editing or printing by any commercially 
available word processing program. To access the Journal, select the Journal item from the 
Windows menu of the LabScribe software or the Journal icon on the LabScribe toolbar.

Calculations In the Analysis window, data can be reduced using mathematical operators like mean or 
maximum. These operators generally take a selection of data, operate on it and produce a 
single number as a result.

A second and quite different type of analysis requires that an entire set of data be trans-
formed, point for point, into a completely different, but related set of data. Transforming data 
into its first derivative is a good example of this type of analysis. LabScribe software includes 
several of these Wave-to-Wave transforms in the right-click menu of each channel. 

The list of available functions is always expanding. LabScribe V1.8 includes: Periodic 
functions, Integrals, Derivatives, Channel Math, Filters, Power, Spirometry, Cardiac, and 
EEG. By default, calculated channels always use the channel immediately above them as the 
raw data channel. This works, if the channel above the calculated channel can be used as a 
source of the signal to be transformed. For example, if you select the Rate function (under 
Periodic) to be displayed on Channel 4 of a 214, the pulse transducer can be connected to 
Channel 3. But, transformed data can also be displayed on channels that do not have inputs 
(Channels 5, 6, 7, 8) or channels that are unused. Going to the Set Raw Channel item at the 
bottom of the channel right-click menu allows the source of the raw data to be selected from 
the channels listed in the submenu. 

These calculations are also available in the Function list on the Channels window of the 
Preferences dialogue window. Functions typically used on signals recorded in a biology lab are 
listed. Functions can be changed, and these modifications can be saved in new settings files 
stored in the Settings Groups.
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Chapter 2: Acquisition

The Basics: 

Time, 
Temporal 
Resolution, 
Sample 
Speed, and 
Aliasing 

Temporal resolution in digitally recorded data is determined by the sampling rate, also known as 
sampling speed. To select a suitable sampling rate, you will need some background on the 
theory and use of analog-to-digital converters (ADC). 

The ADC in the iWorx computer interface takes simple voltage measurements at regular 
intervals. The voltage measurements (Y-axis values) and the times at which the voltages were 
recorded (X-axis values) are sent by the iWorx interface to the LabScribe software as a pair of 
(X,Y) coordinates. The LabScribe software displays these coordinates as data points by plotting 
them. The software then connects the data points with a line to create the smooth, graphical 
appearance of an analog chart recording; but, only the data points themselves are hard 
measurements. The lines that are drawn to connect the data points are “educated guesses” 
made by the software and may be misleading. For example, if the sampling speed being used is 
not fast enough for the data being recorded, the display will not accurately represent the real 
data. This misleading behavior of data acquisition software, can be avoided by using a sampling 
speed that is fast enough for the data being recorded.

When the sampling speed is set in the LabScribe software, the hardware is being told what the 
time interval between samples will be. For example, 100 samples per second equals one sample 
every 10 milliseconds. To avoid creating displays that may be misleading, a simple question 
about the sampling interval needs to be asked: Is there a chance that something important has 
occurred between the sample points?

If the answer is “yes,” then the sampling speed must be increased in order to see and record 
that event. In the example presented in Figure 2-1 on page 9, a sine wave with a frequency of 
100Hz is sent to the ADC. In the screen on the left, the data points, recorded by an ADC set to 
the same sampling speed as the frequency of the sine wave, are marked.

 Figure 2-1: A 100Hz sine wave recorded at 100Hz. The samples coincide with the peaks of 
waves; so, the data points can be connected by a straight line.

Because the sine wave has the same frequency as the sampling rate, each recorded data 
point occurs at the same place in each cycle of the sine wave. In the screen on the right, a 
straight line is the result when the data points are connected by a line. The line is a false repre-
sentation of the real data, which is a sine wave. To fix the problem and render a better picture of 
the data, a faster sampling rate is required. If the sampling rate is increased to 110 samples a 
second, the data points would be a millisecond closer to each other than at 100 samples a 
second, but a 100Hz sine wave would still have only one data point for each cycle. When the 
Chapter 2: Acquisition 9



data points are connected by a line, a sine wave with a frequency of 0.1Hz is displayed on the 
screen. Again, the wave displayed on the screen is not a true representation of the real wave 
because the sampling speed is too slow. 

So, how fast does the sampling speed need to be to record a reasonable representation of a 
real waveform? A general rule of thumb is to sample at a rate that is a minimum of five times 
faster than the fastest frequency of interest in the waveform. 

To determine the optimal sampling frequency, find the shortest event in a sample recording. 
For example, the R wave has the shortest duration of any event in the ECG and should be used 
to determine the sampling speed needed to record a reasonable representation of the ECG. 
Next, find the rise time (in seconds) of the R wave. The rise time is the time it takes the wave of 
interest to go from its start to about 2/3 of full value, In the case of the R wave in an ECG, this 
value is about 20 milliseconds (0.020 seconds). 

Substitute the value 0.02 for the rise time in the following equation to determine the bandwidth 
of the event (R wave): 

0.159/Rise Time = Bandwidth

0.159/0.020 = 8

Finally, multiply the bandwidth by five to determine the minimum sampling frequency needed, 
which is 40Hz in this example. Higher sampling rates give better pictures, at the expense of 
making data files larger. Therefore, choosing a proper sampling speed must be a balance 
between the accurate portrayal of the data and the unwieldy size of the data file.

The default sampling speed set in the LabScribe software is 200 samples per second. This is 
adequate to execute most of the laboratory experiments presented in the laboratory manuals 
furnished with the iWorx teaching kits.

If sampling speeds are set manually, it is always best to 
start sampling the data at the fastest speed possible, then, 
slowly reduce the sampling rate to a speed where data 
initially begins to degrade. Finally, set the sampling speed 
just above the rate that initially cause degradation. See 
the examples of pulse waves sampled at different 
frequencies in the appendix.

Sampling rates are set from the Sampling Speed menu on 
the Channels page of the Preferences dialogue window. 
The Preferences dialogue window is called by selecting 
Preferences from the Edit Menu.

The speeds displayed in the Sampling Speed menu are 
rates per second per channel. This menu is dynamic, the 
maximum available sampling speed will adjust depending 
on how many channels are open.

Make sure the Display Time, as programmed on the 
Channels page of the Preferences dialogue window, is 
set to 10 sec before doing the following exercise.

Exercise 1 Plug the DIN connector on the cable of the pulse transducer (PT-104) furnished with your kit into 
Channel 3 on the iWorx interface. Wrap the plethysmograph firmly around the end of the subject’s 
middle finger.
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2 Open the Channels page in the Preferences dialogue window, and set the sampling speed to 1000 
samples per second. Record 10 seconds of data.

3 Next, set the sampling speed to 500 samples/second and record an additional 10 seconds of data.

4 Repeat this procedure for sampling speeds of 200, 100, 50, 20 and 10 samples/second. 

Using the Dual Cursor function, select a section of each recording block from the Main 
window. Display the section in the Analysis window. Closely examine the recorded data as 
displayed in the Analysis window. Notice that the signal becomes progressively more coarse as 
the sampling rates go down, until eventually the signal is unrecognizable.

Vertical 
Resolution

As stated earlier in this chapter, the ADC takes measurements at regular time intervals to 
produce data points with X,Y coordinates, and that the LabScribe software later plots and 
connects the data points with lines. 

The temporal resolution of the incoming signal was the topic of the previous section of this 
chapter. In this section, the vertical, or voltage, or amplitude resolution of the signal will be 
discussed.

When making a measurement of length with a ruler, the accuracy of the measurement is deter-
mined by how many gradations are printed on the ruler. Clearly, a ruler with gradations every 
eighth of an inch is more precise than a ruler with only a gradation every inch. The more lines or 
gradations there are per unit of measure, the more accurate the ruler. 

If the ADC is considered to be a ruler for voltage, then, its resolution (its number of grada-
tions) is determined by a parameter called “bit depth.” 

In an 8-bit word, or byte, there are 256 (28) different possibilities for the value of the byte. A 9-
bit word has twice that many possibilities (512), a 10-bit word has four times as many (1024) 
and so on. The ADC used in the iWorx 104/204/114 is 12-bit, providing 4,096 different possibil-
ities for measurement. Since the input range of the 12-bit (204/104/114) ADC is fixed at ±5V (a 
full scale difference of 10V), the minimum measurement that can be made with an iWorx 204/
104/114 unit is 10V/4,096, which is about 2.4 milliVolts. On the other hand, the iWorx 214/118 
uses a 16-bit ADC providing 65,536 different possibilities. Since the input range of the iWorx 
214 unit is 10V which can be divided by 65,536, the minimum measurement that the iWorx 214 
can make is 152µV. In the case of the iWorx 118, the minimum measurement is 304µV because 
the iWorx 118 has a input range of ±10V (a full scale difference of 20V) with 16-bit resolution.

It is important to realize that it is not possible to make a measurement with more precision 
than ±2.4mV with the iWorx 204/104/114 (or ±152µV with the iWorx 214 or ±304µV with the 
iWorx 118) unless the bit depth is increased or the input range is narrowed. Changing the bit 
depth requires a different ADC to be in place in the unit. However, the input range can be easily 
narrowed by applying the amplification (gain) to the signal before the signal is presented to the 
ADC. If a 1000X gain is applied to the incoming signal by an amplifier, the minimum resolution of 
the ADC improves to ±2.4µV for the iWorx 204/104/114, ±152nV for the iWorx 214, and ±304nV 
for the iWorx 118.

Signal Conditioning

Gain As pointed out in the section on vertical resolution, there is a minimum voltage beneath which 
the ADC cannot read. This voltage is ±2.4mV for iWorx 204/104/114, ±152µV for the iWorx 214, 
and ±304µV for the iWorx 118. If the signal being measured is very small, additional gain can be 
applied to the signal before it is presented to the ADC.
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For example, consider an ECG, whose total peak to peak amplitude is only 2 mV. The number 
of steps that can be resolved with an iWorx 204 is 2mV/4.8mV or a little more than 2 steps, 
which is not sensitive enough to see any meaningful changes. If an amplifier is placed between 
the signal and the analog to digital converter (ADC), the “raw” signal can be amplified by a 
selected gain. For example, if the gain is 100 times (X100), the 2mV ECG signal becomes a 
200mV signal. Now, when the amplified signal is presented to the ADC, it is 100 times bigger. 
Since the minimum signal of ±2.4mV for the iWorx 204 remains the same and the recorded 
signal is 100 times bigger, the noise is now only 1/40th of the amplitude of the signal (4.8V peak 
to peak /200mV signal). 

If the signal is amplified 100 times (X100) and recorded with an iWorx 214, the results would 
be better. The minimum signal now would represent only 1/658th of the total signal (304µV/
200mV). From this comparison it can be seen that a 16-bit ADC is much more tolerant of small 
signals, making the gain required to view a small signal with a 16-bit unit less critical.

Adding gain to the recording system improves the signal to noise ratio of the measuring 
system, but, the cost is that the ADC cannot see any signal above the +5V or below the -5V 
input limits (+10V and -10V on the iWorx 118). In the case where X100 gain is applied to a 0.1V 
signal, the amplified signal becomes 10V. This is above the +5V input limit of the ADC, so the 
signal is out of range. In fact, the effective input range of iWorx ADC units is equal to ±5V/Gain 
(±10V/Gain for 118). So, if a gain of X10 is used on an amplifier, the effective input range of the 
ADC drops to ±0.5V (±5V range/X10 gain). Any input signal larger than 0.5 volts will be out of 
range. If a gain of X100 is applied to the input signal, the effective input range of the ADC is 
restricted to ±0.05V, and so on.

Bioamplifiers The bioamplifier channels of the iWorx 214/204/114 units apply gain to the input signals 
coming through them, when different recording modes are selected. The following table shows 
the gains applied for the modes selected:

On the iWorx 214/114, the gain and filter modes are selected from the Mode menu on the 
Channels page of the Preferences dialogue window in the Edit Menu, or the Input Mode 
function in the right-click menu of Channels 1 or 2. On the iWorx 204, the gain and filter modes 
are selected by pressing the red mode button on the front panel of the instrument.

DIN 8 Inputs The DIN 8 inputs on iWorx analog to digital converters can apply up to X1000 gain. This is 
accomplished through the placement of a gain programming resistor within the DIN 8 connector 
of the transducer or cable that can be plugged into the DIN 8 inputs of the iWorx units. Gain 
programming resistors are ALREADY PRESENT IN ALL IWORX TRANSDUCERS. Gain 
programming resistors can be installed on NON- IWORX transducers by rewiring the connector. 
Consult the hardware section in the appendix of this manual for the pin configurations and 
diagrams of the DIN 8 connectors used with iWorx ADC’s.

Table 2-1: Gains for Each Bioamplif ier  Mode or Fi lter Setting

Mode 204 114 214

ECG (0.3-150Hz) x1000 x1000 x1000

EMG (3-10KHz) x1000 x1000 x1000

EEG (0.3-35Hz) x10000 x1000 x1000
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Offset Offset is sometimes referred to as “positioning.” Some recorders, amplifiers, and transducers 
have a knob that positions the baseline of the recording on the screen. Positioning control 
permits the centering of the signal which makes measurements more convenient, or the lowering 
of the baseline to accommodate the display of a signal that has more gain applied to it. The 
availability of the AutoScale feature in the LabScribe software reduces the need for a 
positioning knob. In fact, the very low noise of the iWorx 214/118 makes positioning controls 
unnecessary as signals are automatically centered and expanded to fill the recording screen 
when the AutoScale button is clicked. 

Filters Filters can be set to remove certain frequencies from signals. Hopefully, the frequency infor-
mation removed when the filters are applied is noise and not part of the signal of interest. There 
are two basic types of electronic filters: Low Pass and High Pass. When used in combination 
with each other, these filters can create either Band Pass or Band Reject (Notch) filters.

By definition, Low Pass filters PASS only those frequencies beLOW the set frequency. For 
example: in an electrocardiogram, a large percentage of the ECG signal information is contained 
in frequencies below 40Hz. A significant noise source in such recordings is the 60Hz line 
voltage (110V AC power, or mains) used to power equipment and lights. A 50Hz Low Pass filter 
would allow all frequencies below 50Hz (including lots of ECG information) to pass to the 
recorder, but would exclude all frequencies above 50Hz, including the 60Hz noise from the 
mains. The end result of using the 50Hz Low Pass filters is the creation of a quieter, more 
readable ECG. In general, the application of a low pass filter “quiets” the baseline and improves 
the signal to noise ratio of the recording.

On the other hand, High Pass filters PASS frequencies HIGHer than the set frequency. These 
filters can remove low frequency interference, such as baseline drift or a standing offset voltage, 
so that the user sees a more stable baseline.

The simultaneous use of High Pass and Low Pass filters can create a Band Pass filter. Three 
different analog band pass filters are available for the bioamplifiers on the iWorx 214, 204 and 
114. The Band Pass filters on the iWorx 114/214 are enabled automatically when they are 
selected from the Mode menu on the Channels page of the Preferences dialogue window, or 
from the Input Mode function on the right-click menu of Channels 1 or 2. The Band Pass filters 
on the iWorx 204 are enabled when the mode button on the front panel is pressed. These are 
4th order active electronic filters with the following values:

Another set of High Pass, Low Pass and Band Pass filters can also be applied to each 
channel from the Filter function located on the right-click menu of each channel. These filters 
are not “Hardware” filters; they are executed in software and work on all ADC units running 
LabScribe software. Unlike hardware filters, software filters can be applied AFTER the data is 
recorded. These filters also work in real time and can be applied to data as it is being recorded.

Table 2-2: Band Pass Filter Frequencies

Band Appl icat ion 204 214 114

0.3-35 Hz EEG/ECG X X X

0.1-150 Hz ECG X X X

3Hz-10KHz EMG - X X

3Hz-2KHz EMG X - -
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Averaging in 
LabScribe

In addition to filtering, the LabScribe software can apply another quieting technique to data 
recorded at speeds less than 200 samples per second. In the section of temporal resolution, it 
was demonstrated that fast events require fast sampling speeds. What happens if slow events 
are recorded at a fast sampling speeds? More information is collected than is needed to 
accurately display the signal. What should be done with the extra data? At sampling speeds of 
100 samples/sec or less, the LabScribe program operates on the “extra data” using a technique 
similar to the oversampling employed by CD players to reduce noise. The amount of oversam-
pling that occurs is determined by the sample speed that you set. The end result is that small 
signals recorded at slow speed will appear less noisy than small signals recorded at high speed.

Outboard 
Conditioning

The iWorx 114/214/204 contain amplifiers and filters which can be controlled by the LabScribe 
software.These amplifiers and filters should be adequate for most applications. In cases where 
additional or custom signal conditioning is required, outboard devices can be used to condition 
the signal before it is presented to the iWorx ADC. iWorx makes a full range of amplifiers for this 
purpose, but any amplifier with an analog output can be used. This allows other amplifiers, like 
those from Thornton or Grass, or special purpose devices, like those made by Warner Instru-
ments, Axon instruments, or World Precision Instruments, to be used with iWorx ADC units. 
Outputs from these and other devices can be connected to the available BNC inputs on the front 
panel of iWorx ADC units. Outputs of external devices can also be connected to the DIN 8 inputs 
with an adapter cable available from iWorx.

The iWorx 118 contains no built in amplifiers. It depends completely on external devices for 
signal conditioning.

Chart Mode
Once the signal source is connected to the iWorx unit and the signal conditioners are 

configured, data recording can begin. The most basic controls required are the ones that turn 
the recording on and off. LabScribe has three ways to Start a recording and two ways to Stop it.

Starting The dialog boxes (Figure 2-2 on page 14) show the options for starting the recording process 
for both groups of hardware.

 Figure 2-2: The LabScribe Start dialogue boxes

User The easiest away to start the recording is for the User to manually press the Start button in 
the upper right hand corner of the LabScribe Main window. User is the default setting in 
Labscribe. Recording begins when the User presses the Start button. and will continue until one 
of the Stop conditions is met. Pretriggering is not possible in the User (manual) mode.
  14
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External Trigger Sometimes, it is necessary to synchronize the beginning of the recording with the beginning of 
an external event. The LabScribe software can be configured to start recording when the iWorx 
hardware detects a voltage pulse (+3 to +5V amplitude) through the BNC connector of the 
Trigger input. Many devices have Trigger or TTL outputs that are capable of starting the 
LabScribe recording software; these devices include: stimulators, relays, pumps, valves and 
cameras.

Triggered from 
Channel: 

For various reasons, data recording may not need to begin until the data itself reaches certain 
criteria. For example, it may be necessary to record an animal’s body temperature, only if the 
base temperature exceeds 100°F. The LabScribe software could be programmed to begin 
recording when the data on the temperature channel exceeded 100°F. Thresholds above and 
below a certain data value can be set to start the recording.

Open the Preferences dialogue window from the Edit Menu. Click 
on the tab for the Sampling page. Pull down the Start Mode 
menu and select the channel (Ch) that contains the data to be 
used as a trigger. Set the values that the data must meet before 
recording is triggered. The diagram demonstrates that LabScribe 
is programmed to look for a trigger from the data on Channel 1 

when the amplitude of the data is above 1.5V and below 2 V. This feature is NOT available on 
iwx104/204/108 hardware.

Pre triggering When an External Trigger or a trigger from a data channel (Ch)is 
used, the data just before the trigger occurs may be important to 
record as well. For example, if the R wave is used to trigger the 

recording of an ECG, the P wave and other parts of the ECG that occur before the R wave can 
be recorded. The PreTrigger feature of the LabScribe software can be used to look back in time 
and display a small piece of data prior to the trigger. To enable pretriggering, check the box next 
to the label PreTrigger (in the Start Mode box on Sampling page of the Preferences dialogue 
window. Enter the amount of pretrigger time needed in the edit box to the right of the Pretrigger 
label.

Stopping Once recording begins, the LabScribe programs offers two different ways to halt the recording: 
User or Timed.

User User is the default Stop value for LabScribe and can be reset from the Stop Mode box on the 
Sampling page in the Preferences dialogue window. In User mode, the Stop button in the 
upper right hand corner of the LabScribe Main window will stop the recording when clicked. The 
Start button toggles to the Stop button, after the Start button is clicked to begin the recording. 
The Stop button remains visible until it is clicked.

 Figure 2-3: The LabScribe Stop dialogue boxes.
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Timed When Timed is selected as the stop mode, the LabScribe software will stop recording 
automatically after a predetermined time (in ms), which is entered into the edit box.

On an iWorx 104/204/108, the additional option of stopping after a set number of points is 
available.

Scope Mode

When to Use 
the Scope 
Mode

The first devices used to record data were electromechanical. These devices used a stylus or 
very fine pen that was moved by a sensitive motor. The frequency response of these machines 
was very low; the fastest events that they could record were on the order of tenths of a second. 
As science progressed, it became obvious that there were faster things in nature than pen 
recorders could visualize. The oscilloscope or “scope” is able to take a fast, brief snapshot of an 
event, but the continuous chart-like recording was sacrificed. An oscilloscope capturing a fast 
moving electrical signal, like an action potential, is analogous to high speed, stop motion 
photography capturing the movement of a hummingbird’s wing. 

To effectively use the Scope mode in the LabScribe program, the length of the snapshot 
(display time) and the sampling rate need to be set to accurately visualize the event. Events that 
are best captured using the Scope mode are brief and repetitive. Action potentials, and most 
neurophysiological signals, are good examples of signals that are best recorded in Scope mode.

In addition to being able to capture a very brief event in time, a proper trigger is needed to 
begin the recording of the event at the moment it takes place. Using the example of stop motion 
photography, if the high speed camera snapped the picture too soon or too late, the picture may 
not show the event that was trying to be captured. So, the acquisition of data at the right 
moment requires a proper trigger. In the Scope mode either of the previously discussed “non-
manual” modes, External Trigger or Trigger from Channel, can be used to start the sweep.

Acquiring 
Data in the 
Scope Mode

Scope mode can be enabled from the Sampling page in the Preferences dialogue window, 
which is accessible under the Edit Menu. Data can be acquired on as many channels as are 
available in Scope mode. Data can be viewed in either Chart or Scope format with some limita-
tions. Switching between formats can be accomplished by clicking on the ScopeView or Main 
window icons in the LabScribe toolbar. The limitations to viewing data in the Scope or Chart 
format are the following: 

• If data is recorded in Scope mode, each sweep or record segment is treated as a block of data. When 
viewed in Chart mode, sweeps (or blocks) are laid end to end, in the order that they were acquired. Data 
can be scrolled, and any single block can be sent to the Analysis window.

• If data is recorded in Chart mode, the FIRST block or record segment will be taken as the sweep length 
(display time). Each block will appear as a sweep in the ScopeView window.

Set up the 
software

To program LabScribe to record in Scope mode, pull down the Edit Menu and select Prefer-
ences. Open the Sampling page of the Preferences dialogue window. Click on the Scope 
button. Next, set the Start mode that will begin the recording of the sweep. The triggers that are 
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available are: User, for manual starting of the sweep that can be linked to the output of the ADC; 
External Trigger, for triggering by an external source; Trigger by Channel, for triggering by an 
input signal.

 Figure 2-4: The Scope application setup controls

Next, the acquisition mode needs to be selected. This mode can be set to either Repetitive or 
Multiple, and is selected from the drop-down menu next to the Scope button on the Sampling 
page of the Preferences dialogue window.

Repetitive mode When the Start button is clicked in Repetitive mode, each new sweep overwrites the previous 
sweep. Real oscilloscopes work in this way. When the Stop button is clicked, only the last trace 
is saved.

Multiple sweep 
mode

When the Start button is clicked in Multiple Sweeps mode, LabScribe will acquire and save a 
predetermined number of sweeps. The number of sweeps in a series can be typed in the 
Sweep(s) box on the Sampling page. The beginning of each recorded sweep is determined by 
the Start mode conditions. A Delay Between Sweeps can also be programmed in the Multiple 
Sweep mode. If zero is selected as the Delay Between Sweeps, the next sweep in the series is 
taken as soon as the software is ready, which is typically in 2 to 5 milliseconds.

Sweep Length When operating in Scope mode, LabScribe takes “snapshots” of data. Each “snapshot” is 
called a sweep and has a pre-determined length. The sweep length (or display time) is set in 
the Stop Mode section of the Sampling page from the Preference dialogue window. By 
choosing Timed as the Stop Mode, the sweep length (in msec) can be entered into the edit box 
in that section of the page.

Sampling Rate Determining the optimal sampling frequency in Scope mode is the same procedure as used for 
Chart mode. First, find the shortest event in the record. If the compound action potential is used 
as an example, the spike goes from baseline to about 80% of its full amplitude in about 0.35 ms. 
If you substitute.00035s for the rise time in the following equation:

0.159/Rise Time = Bandwidth

0.159/0.00035 = 454

If the bandwidth is multiplied by five, the minimum sampling frequency is 2270Hz. Doubling 
the sampling rate to 5kHz insures that the trace recorded is representative of the signal.

If the entire event of interest is only 0.1 sec long, a sweep at 5,000 samples per second 
occupies only 500 data points. Since the LabScribe program can accommodate up to 100,000 
points per screen while recording, there is substantial room available for a wider display or a 
greater sampling rate.
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Saving Your Data

Every Software manual has a section on the importance of backup and saving. LabScribe is no 
different. SAVE YOUR DATA! 

Consider that the data acquisition process imposes new and different constraints on the task 
of saving data. A word processor or spreadsheet document can be saved anytime that the user 
thinks about it. The user simply stops writing and saves the document. 

In a data recording application, data is constantly being added, sometimes at fantastic rates! 
(200,000 bytes/second at top speed) To save data, would require the recording to be stopped. In 
most recording applications, this is impractical. 

When the recording is stopped LabScribe saves the current data to disk. This file can be seen 
in the LabScribe folder as backup.iwd. As the LabScribe program acquires data, it buffers the 
unsaved raw data to a file on the hard disk. This file can be seen in the LabScribe folder as 
iwx_d_bin.buf. In the event of an unexpected loss of power or computer crash, the data is 
preserved. When the LabScribe software is reopened after such an event, LabScribe will ask the 
user if they want to recover the data. If the answer is yes, the backup file is recovered and data 
is preserved. To view the recovered data file, use the Open command in the File menu to open 
the backup.iwd file. To permanently save the data, use the Save As function BEFORE 
RECORDING ANY NEW DATA. Recording new data will overwrite the backup.iwd file. 
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Chapter 3: Display

Introduction
From a functional standpoint, the LabScribe program is really two programs. It is primarily a 

data acquisition application, whose main task is to record analog experimental data as data 
points (with X and Y values) and store these data points on the computer. The second task of 
the LabScribe program is to graphically display the collected data in a way that is under-
standable to the user. Chapter 2 explains the various controls and options relative to the acqui-
sition of data. This chapter will discuss considerations regarding the display of collected data on 
the various windows in the LabScribe user interface.

User 
Interface

The LabScribe user interface contains seven primary windows; Main, Analysis, ScopeView, 
XY, FFT, Marks, and Journal. There are also dialogue windows, accessible through the Prefer-
ences selection in the Edit Menu, which provide controls of the Channels, Sampling, Stimu-
lator, computed Functions, Output Sequences, and Advanced. Most of the interface related 
features in LabScribe can be found in the Main window (Figure 3-1 on page 19). LabScribe can 
display up to sixteen channels in the Main window.

 Figure 3-1: The LabScribe Main window.
Chapter 3: Display 19



Each channel has its own set of controls located in a Channel Bar immediately above each 
channel’s data window (Figure 3-2 on page 20). Y-axis scaling is printed to the left of the data. 
The Channel Bar contains the Channel Title, buttons for Y-axis display control (Autoscale, 
Zoom-In, Zoom-Out, FullScale, and Preferred Scale) and a Value Display area. The Value 
Display box located to the extreme right on the channel bar will display different things 
depending on the state of the program. While recording, the Value Display box shows the value 
of the last data point collected. Off-line, in Single Cursor mode, the Value Display box displays 
the Y-axis value of the data point intersected by the cursor. In Dual Cursor mode, the Value 
Display box displays the difference between Y-axis values intersected by the 2 cursors.

 Figure 3-2: The common controls for channels displayed in the LabScribe Main window.

Cursors If someone handed you a paint brush, gestured in a general direction, and said: “Paint that!”; 
you would probably want to clarify exactly what “that” was. In mathematical terms, the verb 
“paint” is the function and the object “that” is the argument. In mathematical operations, it is 
important to understand exactly the “that” you are operating on. 

This is also true for LabScribe software. Many commands are included in the program that 
allow the user to zoom, measure, and calculate. In order for these commands to work, a 
mechanism is required for instructing the software about the area of data or specific data points 
to be addressed. LabScribe uses cursors to identify the data points. This explanation of cursors 
begins with basic modes of operation and applies them to problems in the windows where the 
cursors are used.

Cursor Modes Cursors are vertical lines that pass through all channels. The LabScribe software has two 
cursors. Icons in the toolbar allow you to choose between using Single Cursor or Dual Cursor 
modes (Figure 3-3 on page 20). Cursors can also be “garaged,” or placed all the way to the left 
hand side of the data so they measure or report nothing. Cursors in the LabScribe software are 
always in one of three modes — garaged, single, or dual.

 Figure 3-3: Cursor controls on the 
LabScribe Main window toolbar.
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To access Single Cursor mode, press the Single Cursor icon (Figure 3-3 on page 20) in the 
toolbar. In this mode, the value of the data point on each channel, that is intersected by the 
cursor bar, is reported in the Value Display area on the right side of each channel bar. The time 
for the position of the cursor is reported in the Clock Area in the upper left hand corner of the 
Main window. Single Cursor mode is used to determine values and to place marks in the record 
after recording has stopped. 

To access Dual Cursor mode, press the Dual Cursor icon (Figure 3-3 on page 20) in the 
toolbar. In this mode, the Value Display area reports the difference in value between Cursor 1 
and Cursor 2. In a similar way, the Clock Area reports the difference in time between the two 
cursors. When using Dual Cursor mode, the cursor farthest to the left is always Cursor 1 and 
the other to the right is always Cursor 2. Dual Cursor mode is also used to define the right and 
left boundaries of a selection of data. This selected area can be used to define the contents of 
the Analysis window, or to determine what two values are used to accomplish the Units 
Conversion function.

Moving Cursors Once cursors have been called, they may be moved by placing the mouse over the cursor bar, 
clicking, holding, and dragging them to the right or left. Cursors may also be moved using the 
arrow keys on the keyboard. In Dual Cursor mode, you can change the cursor that is moved by 
using the UP arrow. Pressing the RIGHT or LEFT arrow key on the keyboard, moves the cursor 
one data point. Holding the SHIFT key down while using the arrow key causes the cursor to 
move 5 data points at a time; and, holding the CONTROL key down while pressing a RIGHT or 
LEFT arrow moves the cursor forward 10 points at a time.

Behavior of 
Cursors

In Single Cursor mode, the value displayed represents the value identified on the channel by 
the one and only cursor. If the data is scrolled so that the cursor goes off screen, the cursor is 
automatically garaged, and the channel display area will display the value of the visible data 
point furthest to the right.

In Dual Cursor mode, Cursor 1 is always the left hand cursor. If Cursor 2 is moved to the left 
of Cursor 1, it becomes Cursor 1. Values reported in the Value Display area are always the 
difference between Cursor 2 and Cursor 1 (Cursor 2 minus Cursor 1). If the data is scrolled, so 
that one of the cursors is no longer on the screen, that cursor is automatically garaged and the 
display goes to Single Cursor mode.

Exercise Load the datafile Exercise1.iwd in the Program Files->iWorx->LabScribe->tutorial files folder, 
by selecting the Open item in the File Menu. The data displayed on Channel 1 is a ±2V sine 
wave. Note that the Value in the Value Display area corresponds to the voltage of the last data 
point (farthest to the right) in the window.

• Select Single Cursor mode by pressing the Single Cursor icon in the toolbar (Figure 3-3 on page 20). 

• Record the value that corresponds to the position of the cursor. 

• Click, hold, and drag the cursor over the highest point in a given cycle of the data. Adjust the position of 
the cursor bar left or right by using the LEFT or RIGHT arrow keys on the keyboard. Adjust the position of 
the cursor bar so that the Value in the Value Display area reads +2V.

• Call the Dual Cursor mode by pressing the Dual Cursor icon in the toolbar (Figure 3-3 on page 20).

• Position Cursor 1 so that it is over the maximum value in a given cycle, then position Cursor 2 over the 
minimum value as shown (Figure 3-4 on page 22). The Value reported will be 4V.

• Now, drag Cursor 2 to the minimum value before Cursor 1. When you release Cursor 2, it becomes 
Cursor 1 and the new Value reported is -4V.
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 Figure 3-4: Cursors placed on LabScribe Main window to measure voltage difference, V2-V1.

Main Window Display Considerations
Recorded data has two important dimensions: Length and Height. The length is the Time axis 

and the height is the Amplitude. Each of these has its own set of controls 

Managing 
Display Time

The events recorded using LabScribe software may occur over varying time frames. For 
example, recording the discharge curve of a 9-Volt transistor battery could take hours, while 
recording the QRS complex in a human electrocardiogram might take only a fraction of a 
second. LabScribe software allows the recording of both very slow and very fast events while 
displaying the recorded results in a format that is easily interpreted. To manage the time display 
in the LabScribe software, we use a parameter called Display Time. Display Time is the 
amount of time represented by one full screen of data. When the program opens, the default 
Display Time is set to 10 seconds. Display Time can be changed by using the display controls 
in the toolbar (Figure 3-5 on page 23), or by manually entering a Display Time in the place 
provided at the top of the Channels page of the Preferences dialogue window, which is 
launched by selecting the Preferences under the Edit menu.

Clicking the Half Display Time icon (big mountain) halves the screen time. If you clicked this 
icon once, a 10-second full-screen display would become a 5-second, full-screen display, This 
doubles the screen resolution, but cuts the amount of data seen on the screen in half. Clicking 
the Double Display Time icon (little mountain) doubles the screen time. In this case, a 10-
second, full-screen display would become 20-seconds wide. This reduces the screen resolution 
by half, but doubles the amount of data that you see on the screen.
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 Figure 3-5: Display Time icons in 
LabScribe Main window toolbar.

Limits Using the Double Display Time control compresses the data. The display time can be 
doubled as many times as requested until the limit of the maximum size of the data file or 
1,000,000 data points. While recording, a maximum of 100,000 data points can be displayed in a 
single screen. 

Using the Half Display Time tool expands the record as many times as requested. But, the 
Labscribe program will not display less than 10 data points on a screen of data.

Double-clicking the Display Time area at the top of the Main window resets the X-axis time 
display to the default value originally entered on the Channels page of the Preferences 
dialogue window.

Examples Here are two examples demonstrating the use of the Display Time feature. In the first 
example (Figure 3-6 on page 23), a human electrocardiogram is recorded with a 160-second 
screen time. Notice that the record is compressed and it is impossible to resolve detail in 
individual events. By clicking Half Display Time five times, the screen time is reduced from 160 
seconds to about five seconds, making individual events clearly visible.

 Figure 3-6: ECG viewed with a long screen time (top) and a short screen time (bottom).
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In the second example (Figure 3-7 on page 24), a one hour battery discharge curve is shown 
in two views. The 2-second screen time shows almost a straight line, but clicking Double 
Display Time eight times reveals the entire curve. The Display Time parameter, with its two 
controls, effectively handles the time display.

 Figure 3-7: Voltage drop of 9-Volt transistor battery viewed with short 
(top) and long (bottom) screen times.

Managing 
Amplitude 
Display

The vertical display of your signal is managed in a number of ways. In each channel toolbar 
(Figure 3-8 on page 24), there are six icons. They represent: Zoom-In (x2), AutoScale, Zoom-
Out (x2), Full Scale, Preferred Scale, and Set Preferred Scale features. In addition, on the 
right side of each channel display area is a scroll UP/DOWN control to offset the recorded wave 
up or down. 

 Figure 3-8: The channel toolbar in the LabScribe Main window.

AutoScale AutoScale, as used in the LabScribe software, reviews the current screen of data on the 
channel of interest and locates the highest and lowest data points in that screen. It then adjusts 
the Y-scale range to include those points. To use AutoScale, click on the center button in the 
first group of three on the upper left side of each channel bar.

FullScale Pressing the FullScale item adjusts the Y-scale to its maximum value of +/-5Volts (+/-10Volts 
on the 118). 
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Zoom-In/Out From any view of data, pressing the Zoom-In button will double the displayed size of the 
trace. Pressing the Zoom-Out button will reduce the displayed size of the trace by a factor of 2.

Preferred Scale For any data, there is a basic range within which the Y values of the signal will occur. For 
example, if measuring room temperature, the user might select a range of 50oF to 100oF 
because it is doubtful that the signal will move beyond these limits. If an event of interest occurs 
during the recording, the area of interest can be expanded using the Zoom or AutoScale tools. 
To return to the Preferred Scale set by the user, simply click the P.S. button in the channel 
toolbar.

Set Preferred 
Scale

To set the range of the Preferred Scale, click the SET icon in the channel toolbar and enter 
upper and lower limits of Y-scale in the Set Scale dialogue window that appears. 

Scroll Up/Down When the Zoom tools are used, the data may drift above or below the center of the display 
area, or even go out of the range of display. To adjust the position of the trace on a channel, 
click the Up or Down arrow buttons to the right of the channel’s data display area.

Channel Handles

 Figure 3-9: The height of the data displays for four channels in the 
Main window as set by the default setting (top), and after the handle 
for Channel 1 was slid down (bottom).

In addition to scaling the height of the signal to fit in a given channel area, the amount of 
display area allotted to each channel in the Main window can be controlled using the channel 
handles, the small red triangles to the right of each channel bar. To change the allocated space 
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for a channel, click on the channel handle and drag it up or down (Figure 3-9 on page 25). 
Notice that when one channel bar is dragged into another, both move. This way all channels 
above and below a channel of interest can be minimized with just two mouse strokes.

Converting 
Units

When used with iWorx or National Instruments hardware, the LabScribe software functions as 
a calibrated voltmeter, which means the software will accurately display the exact voltage that 
the user presents to the analog-to-digital converter. The displayed (and default) units will always 
be Volts. While this is useful in many cases, it is not always the most appropriate unit. 

If the LabScribe software is used to record the output of a transducer designed to measure a 
physical parameter, such as force or pressure, other units are more appropriate. In these cases, 
Volts can be changed into milligrams or grams. The LabScribe software can handle these 
conversions easily, provided that the function (or transducer) that relates voltage to real units is 
linear.

The first step in converting voltage input to real units is to record a portion of data at two 
known values. In the case of a force transducer, record output at two known forces such as zero 
and 100 grams. The recorded trace may look something like Figure 3-10 on page 26.

 Figure 3-10: Data file of weights hung from a transducer and the units conversion dialogue window that sets volts to grams.

Once recording is complete, proceed to the Dual Cursor mode in the Main window. (See the 
Cursors section of this chapter.) The Units Conversion dialogue window cannot be entered 
without being in Dual Cursor mode. Position Cursor 1 over one of the known values, and 
Cursor 2 over the other known value. 
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 Figure 3-11: The Units Conversion dialogue window showing the 2-point calibration boxes.

Right-click the mouse anywhere on the channel to be converted to open the right-click menu. 
Select Units from the right-click menu and the Units dialogue window will appear. The typical 
conversion of the output of a tranducer is a 2 point calibration, which is the default conversion 
method (Figure 3-11 on page 27). Below that menu is an area where the values for the positions 
of the cursors are listed. The values on the left are the voltage values at the positions of 
Cursors 1 and 2. Enter the corresponding values in real units into the two value boxes on the 
right. In the Name area, enter the name of the unit to be displayed on the Y-axis. If a unit name 
is not entered, Volts will be used as a default name.

If the data to be converted is noisy, the exact values at the cursors may introduce an error that 
can be large. By entering a non-zero number (N) in the average box at the bottom of the Units 
Conversion dialogue window, the Y-values for the N points on either side of the cursors will be 
averaged to yield a smoothed value with less error due to noise. Typical settings for the number 
of points used in the average value is 3 or 4 points for the 200 samples/sec setting.

 Figure 3-12: The Units Conversion dialogue window showing slope and offset boxes.

It is also possible to set the slope and offset directly, if those values are known (Figure 3-12 
on page 27). For example, if a pressure transducer produces 5mV (0.005V) per mmHg, the 
slope would be 0.005 and the units would be mmHg. To use slope in a units conversion, the 
slope must be expressed as Volts/unit. Ideally, when a sensor puts out zero volts, the value of 
the converted units would also be zero. For many sensors this is true. However, there are many 
sensors that can have their offset changed by ambient conditions, such as changing barometric 
pressure. To correct for sensor offset, determine the value (in converted units) that LabScribe 
reports on the screen when the sensor should be reading zero. Enter this value in the offset 
area of the Units Conversion dialogue window.
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 Figure 3-13: The Units Conversion dialogue window showing offset only boxes.

Sometimes, it is necessary to keep the units conversion relationship and change the offset, 
like turning the offset control on an amplifier. For example, if we want to set a particular region 
to zero, set the two cursors around the desired region of data. Select Units from the right-click 
menu. Choose offset only from the drop-down menu (Figure 3-13 on page 28). The average 
value between the two cursors can now be set to the required offset value (zero, in this 
example).

Units can also be set from the Channels page of the Preferences dialogue window. Each 
channel can be set with the conversion factors provided by the transducer manufacturer (see 
the section on Preferences in this manual).

All of the recorded data, acquired by the hardware as raw data, are displayed as voltages. 
From time-to-time, it may be desirable to turn off the Units Conversion, and simply view the 
raw data. To view raw data, open the Units Conversion dialogue window (Figure 3-11 on page 
27). Notice that the program reports the current values in voltage at each cursor and the repre-
sentative converted values.   Selecting Off in this dialogue window returns the original display to 
Volts as the default unit.

Inverting the 
Trace

When recording physical parameters, such as temperature, pressure or force, it is best if the 
polarity of the data display matches the real-world behavior of the parameter. For example, if the 
observed temperature goes up, the trace on the computer screen should go up. Increasing 
pressure or force should also produce a positive or upward deflection of the trace. 

Depending how sensors and amplifiers are wired, this may or may not be the case. In the 
event that the data display has the wrong sense or polarity, the trace can be inverted by 
selecting Invert from the right-click menu of any data channel. As with Units Conversions, the 
Invert function can be switched Off at any time. 

Marks The LabScribe software can record lots of data, but the data of interest must easily be located 
and retrieved to be useful. Also, information needs to be extracted from the data to make it 
useful. To locate specific sections of data and to differentiate parts of the record from one 
another, it is possible to put Marks on the data while LabScribe is recording. Marks are one of 
three navigation tools provided by the LabScribe software. In addition to being made on-line. 
Marks can be inserted and edited after the recording has stopped.
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Making Marks 
On-Line

Marks (and their associated comments) can be placed on the recording without interrupting 
the flow of data to the computer. 

As soon as the Start button is clicked and data recording begins, the LabScribe program sets 
an active text cursor on the Mark line, next to the Mark button on the Main window. On the Mark 
line, the user can type a comment describing an upcoming step in the experiment. The comment 
will be associated with the next mark that is placed on the recording. 

The mark is placed on the recording when the Enter (or Return) key on the keyboard is 
pressed, or the Mark button on the Main window is clicked. The mark will be signified by a 
vertical line that is inserted on the data at the moment the Enter key is pressed or the Mark 
button is clicked. When recording is halted, the typed comment that was loaded on the Mark line 
prior to the event can be seen in the Text Display area at the bottom of the screen.

A mark is time-locked to the record at the moment the Return or Enter key is pressed. An 
unlimited number of marks can be attached to the record. The vertical line on the recording, that 
is associated with a mark, is provided as visual confirmation that the mark has been placed. 
While data is being recorded, only one mark can be seen on a given screen. Offline all the 
marks are visible.

Making Marks 
Off-Line

Marking events as they happen is a necessity for events that are time critical, like drug deliv-
eries or experimental interventions. Information about the experiment that is important, but not 
time critical, can be marked on the recording after the recording is completed. An example of the 
type of comment to be added to the record would be a change in room temperature. 

To add this information to the record after recording is completed, select the Single Cursor 
mode from the LabScribe toolbar. Position the single cursor bar on the record where the mark is 
to be positioned. Type the text (a maximum of 50 characters), associated with the new mark, on 
the Mark line in the Main window. Click the Mark button; and, the mark and its text comment are 
inserted at the position of the cursor.

Editing Marks Marks already on the record can be changed by going to the Marks window, available from the 
Window menu or the LabScribe toolbar. The Marks window is a dialogue box containing a list of 
all marks in a record (Figure 3-14 on page 29).

 Figure 3-14: The LabScribe Marks window.
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To edit a mark, highlight the mark, change the text of the comment associated with the mark in 
the edit box at the top of the window, and click the Edit button in the upper left hand corner of 
the window. Marks can also be edited or deleted by right-clicking on the comment in the Text 
Display area at the bottom of the Main window.

Navigating By 
Marks

Marks that are placed on the recording can serve as “sign posts”, indicating where important 
sections of data are located. By highlighting a specific mark listed in the Marks window and 
clicking the Go To button, the LabScribe software will find the data point associated with that 
mark and display that section of data in the Main window. In this manner, the user can move 
between important areas of an experiment without hunting or scrolling for the areas of interest.

Positioning Mark 
Comments

On presentations or printed copies of the data record, it is useful to position the text of the 
comment associated with a mark directly over the data to which it applies. This is particularly 
useful if more than one channel of data was recorded, and the mark does not apply to all 
channels.

 Figure 3-15: Comments moved on to the channel data display in the Main window.

When marks are created, the comments appear in the Text Display area at the bottom of the 
Main window above the Time axis. After recording has stopped, comments associated with 
marks can be dragged into the data area of the record. The text of these comments can be read 
and printed in any window in which the data appears (Figure 3-15 on page 30).

Sometimes, it is necessary to return the marks in a particular view to the Text Display area at 
the bottom of the Main window. To do this, select Marks from the View menu and Reset 
Location from the Marks submenu. This command returns only the mark comments on the data 
window of the current screen of data to the bottom of the Main window. All other marks will 
remain where they were originally positioned. The Reset Marks command is active only on the 
Main window.
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Exercise 1 Click Start and record a few minutes of data. 

2 As data is being recorded, type the word “Test 1” on the keyboard and strike the Return or Enter key on 
the keyboard.

3 Wait one minute, type “Test 2" and strike the Return or Enter key.

4 Click Stop. Scroll through the data using the scroll bar on the bottom of the Main window until you 
locate “Test 1” in the Text Display area.

5 Open the Marks window from the Window menu, or by clicking on the Marks icon in the LabScribe 
toolbar. Select the mark “Test 2" in the Marks window.

6 Click on Go To to close the Marks window. Notice that the record in the Main window has moved to the 
“Test 2" mark.

7 Using the mouse, click and hold on the comment “Test 2" at the bottom of the screen. Continue holding 
the mouse button down, and drag the mark comment to a new position on one of the available 
channels. 

8 Release the mouse button and the mark is locked on the selected channel. Comments positioned in this 
way will remain where they are placed and will print exactly as you see them. 

9 Try this exercise again with a mark created off-line. To create an off-line mark, open the Single Cursor 
mode by clicking the Single Cursor icon in the LabScribe toolbar. Position the cursor where the off-line 
mark is to be positioned. Type some text on the comment line at the top of the screen, and press the 
Return or Enter key. The mark appears at the cursor location and the comment appears at the bottom 
of the screen.

Sorting and 
Exporting marks

The Marks window displays the Time that a mark was made, the text comment attached to the 
Mark, the Channel on which the mark was made, and the Value of the amplitude at the mark. 
Marks can be sorted by Time, Channel, or the text comment of the Mark by clicking on the 
column titles. Click once to organize marks in ascending order, and a second time to change to 
descending order. 

Using the standard Windows commands, SHIFT-CLICK and CONTROL-CLICK, specific marks 
can be highlighted. Once selected, use the Export button to send selected marks to a text file 
which can be opened in Excel or another spreadsheet program.

Voltmeter Large digital readouts of the amplitudes recorded on each channel can be displayed on the left 
side of each channel in the Main window. Select the Voltmeter function from the View menu to 
display these readouts. The readouts are active while data is being recorded, can display the 
amplitude of the trace on each channel at the position of a Single Cursor, or can display the 
difference in amplitudes between the positions of Dual Cursors on each channel.

Views LabScribe V1.8 can acquire data on up to eight channels on the iWorx 118 (four channels on 
the iWorx 104, 114, 204, or 214), but it can display data on up to sixteen channels. The extra 
channels can be used to display computed functions that are mathematically derived from the 
raw data. For example, the arterial pressure from eight different animals could be recorded on 
channels 1-8. Simultaneously, the Rate function could be used on Channels 9-16 to calculate 
the heart rate of each animal from its recorded blood pressure on Channels 1-8. As with any 
multi-channel display, the more channels that are displayed means there is less space that can 
be given to each channel. In the case of a 16-channel Main window display, it is hard to resolve 
detail in the trace of recorded data in each channel. 
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LabScribe solves this problem by allowing the user to create as many as eight different collec-
tions of channels that can be displayed on the screen at one time. Each collection of channels 
that is displayed is known as a View. Using the example from the previous paragraph, a View 
could be created that displayed the arterial pressure from Channel 1 and the calculated heart 
rate for the same animal displayed on Channel 9. The data from Channels 1 and 9 would appear 
in the first and second data display areas, respectively. The other fourteen raw data and 
computed heart rate channels would not be displayed. For the data recorded from another 
animal on Channel 2, another view with Channels 2 and 10 (its matching rate channel) can be 
created. Each VIEW can have up to eight channels

Using VIEWS To use Views, select Preferences from the Edit menu to open the Preference dialogue 
window. Click on the Advanced tab to open that page. Select the number of different views that 
you want to create from the dialogue box at the top of the page. Enter a number equal to or less 
than 8. 

For each view listed, check the boxes for each of the sixteen available channels to be 
displayed in that view. A check in a given box will include that channel in the view. Up to 8 
channels may be selected. Channels will be displayed in numerical order starting with the lowest 
number. Each view can also be given a name. Click OK to exit the Advanced page.

Once created each view will be listed as a display option in the View menu. You can change 
views at any time by selecting its name from the View menu.

Display Considerations in Other Windows 
Data is only recorded in the Main window. However, other windows can receive selected data 

from the Main window for closer examination or display in another format, like a XY plot or FFT. 
There are several viewing options available in these other windows that are not available in the 
Main window. The actual discussion of analytical functions found in these windows is deferred 
to the Analysis chapter, later in this manual.

The Analysis 
Window

Data can be imported into the Analysis window from the Main window using the Dual 
Cursors. The data to be transferred to the Analysis window is selected by placing the cursors 
on either side of the data of interest. Once the data is selected, it is transferred from the Main 
window to Analysis window when the Analysis icon is selected from the LabScribe toolbar or 
Analysis is selected from the Window menu. In the Analysis window, all channels are 
displayed and AutoScaled. A segment of data from an 8-channel record, with only Channels 1 
and 3 displayed, is shown in Figure 3-16 on page 33. 

Channels are selected for display by clicking on the Channel Titles in the Display Channels 
list on the left margin of the Analysis window. Multiple channels can be selected using the 
standard Windows SHIFT-CLICK and CONTROL-CLICK commands to add or remove channels.

The default view will show all selected channels in Tiled mode, one channel above the other 
in the display (top, Figure 3-16 on page 33). Checking the Stacked box (on the left margin of the 
Analysis window) will overlay the selected channels (bottom, Figure 3-16 on page 33).

Expanding or contracting the time displayed in the Analysis window can be controlled by two 
different methods. The Display Time buttons (Half or Double Display Time) at the top of the 
Analysis window can be used, as well as the Zoom In and Zoom Out functions in the right-
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click menu of the window. To open this menu, right-click in the data display area of the 
Analysis window. These Zoom functions behave exactly like the Display Time functions in the 
LabScribe toolbar.

 Figure 3-16: Two channels of data displayed in tiled mode (top) and in stacked mode (bottom) on the Analysis window. 

As in the Main window, data can be scrolled using the bar at the bottom of the Analysis 
window. The user can also move forward and backward through the recording, a block of data at 
a time, by clicking on one of the B buttons at either end of the scroll bar in the Analysis window.

By default, the Analysis window displays Channel Amplitude data on the Y-axis and Time on 
the X-axis.

Data on any channel can be substituted for Time by selecting a Channel Title from the list box 
in the lower right-hand corner of the Analysis window (Figure 3-16 on page 33). 

In this way, XY or XYY plots can be constructed. When the Analysis window is in XY mode, 
the functions or calculations available in the Table Functions list change to choices more 
appropriate for the XY plot. This is discussed in greater detail in the Analysis chapter.
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The XY 
Window

Data can be imported into the XY window from the Main window using the Dual Cursors. The 
data to be transferred to the XY window is selected by placing the cursors on either side of the 
data of interest. Once the data is selected, it is transferred from the Main to XY window when 
the XY icon is selected from the LabScribe toolbar, or XY View is selected from the Window 
menu.

In the XY window, there are two linear displays (Y,T) and an XY plot (Y1,Y2). The linear 
displays are plots of the amplitudes (Y-values) as a function of time for the channels selected for 
the XY plot. The channels to be used in the XY plot are selected by highlighting the title of the 
channel from the drop-down list next to each linear display. 

Expanding or contracting the time displayed in the XY window can be controlled by two 
different methods. The Display Time buttons (Half or Double Display Time) at the top of the 
XY window can be used, as well as the Zoom In and Zoom Out functions in right-click menu of 
the window. To open this menu, right-click in either of the linear display areas, or on the 
display area of the XY plot. As before, these Zoom functions behave just like the Display Time 
functions on the LabScribe toolbar. 

 Figure 3-17: Two channels of data displayed in linear (top) and in XY plot (bottom) on the XY Window. 

Data in the XY window can be scrolled using the bar underneath the linear displays. The user 
can also move forward and backward through the recording, a block of data at a time, by 
clicking on the Block Down and Block Up buttons on either end of the scroll bar in the XY 
window.

When the XY window is open, only the functions and calculations more appropriate for the XY 
plot are available in the Table Functions list. This is discussed in greater detail in the Analysis 
chapter.

The FFT 
Window

Data can be imported into the FFT window from the Main window using the Dual Cursors. 
The data to be transferred to the FFT window is selected by placing the cursors on either side of 
the data of interest. Once the data is selected, it is transferred from the Main to FFT window 
when the FFT icon is selected from the LabScribe toolbar, or FFT (Spectrum) is selected from 
the Window menu.

In the FFT window, there are a linear display (Y,T) and a FFT plot. The linear display is the 
plot of the amplitude (Y-values) as a function of time for the channel selected for the FFT plot. 
The channel to be used in the FFT plot is selected by highlighting the title of the channel from 
the drop-down list next to the linear display.
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Expanding or contracting the time displayed in the FFT window can be controlled by two 
different methods. The Display Time buttons (Half or Double Display Time) at the top of the 
FFT window can be used, as well as the Zoom In and Zoom Out functions in right-click menu 
of the window. To open this menu, right-click in either of the linear display areas, or on the 
display area of the FFT plot. As before, these Zoom functions behave just like the Display 
Time functions on the LabScribe toolbar. 

Data in the FFT window can be scrolled using the bar underneath the linear display. The user 
can also move forward and backward through the recording, a block of data at a time, by 
clicking on the Block Down and Block Up buttons on either end of the scroll bar in the FFT 
window.

 Figure 3-18: Two views of Data displayed in linear (top) and in FFT Mode (bottom) on the FFT Window. 

When the FFT window is open, only the functions and calculations more appropriate for the 
FFT plot are available in the Table Functions list. This is discussed in greater detail in the 
Analysis chapter.

The Scope 
Window

As described in the Acquisition chapter, Scope mode is a different way of looking at the data 
being recorded. Normally, the events recorded in Chart mode are slow and continuous. The 
events recorded in Scope mode are fast and collected in a series of sweeps of limited duration. 
All of the sweeps in series are the same length. 

Moving data from the Main Chart window to the Analysis window allows the data from the 
same time segment for each recorded channel to be overlaid. The ScopeView window is similar, 
but it allows different time segments of the same channel to be overlaid on the window. 

In ScopeView, the Channel pop-down menu lists the channels that can be displayed in the 
ScopeView window. Selecting a channel will have its sweeps or blocks displayed in the 
ScopeView window. The Display Sweeps list box controls which sweeps for the selected 
channel are displayed. Multiple sweeps can be selected using the standard Windows SHIFT-
CLICK and CONTROL-CLICK commands to add or remove sweeps.
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Chapter 4: Controls

Menus

File The LabScribe software supports all of the elements found in a standard File menu: 

 Figure 4-1: The LabScribe File menu.

New: Opens a new file. Only one acquisition window may be open at a time. This function 
is also available from the toolbar.

Open: Opens a previously recorded file, and is also available from the toolbar.

Save: Saves data to the file currently open, and is also available from the toolbar.

Save As: Saves data to a new file with a different name or format.

Export: Allows the user to export the data viewed as text, a picture, or in a variety of formats 
appropriate to external analysis programs.

Doc Properties: Shows sample speed, gain and other information concerning the data in the 
file

Print: Prints the window in the foreground, and is also available from the toolbar.

Print Preview: Previews the image to be printed.

Print Setup: Dialogue box for control of the printing characteristics.

Recent File: Displays the last four files opened by LabScribe.

Exit: Quits the program.
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Edit The LabScribe software supports elements found in a standard Edit menu: 

 Figure 4-2: The LabScribe Edit menu.

Undo: Un-does the last command.

Cut: Inside the LabScribe program, Cut and Paste commands work only in the Journal. 
Also available from the toolbar.

Copy: Copies the window in the foreground to the clipboard for pasting. Also available 
from the toolbar.

Paste: Pastes the contents of the clipboard to the Journal. Also available from the 
toolbar.

Preferences: Calls a multi-page dialogue box that controls settings for Channels, Sampling, 
Stimulator, computed Functions, Output Sequences, and Advanced items.

View The View menu supports display elements unique to the LabScribe software.

 Figure 4-3: The LabScribe View menu.

Tool bar: Hides or displays the LabScribe toolbar.

Status bar: Hides or displays the Windows status bar.

Output Sequence Bar: Hides or displays the Output Sequence toolbar.

Display Views Bar: Shows the available channel views in a toolbar

Stimulator Panel: Hides or displays the Stimulator toolbar.
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Voltmeter: Displays amplitude values in large type and in digital voltmeter fashion, to the left 
of each channel display window.

Grid: Displays a 20 x 8 grid on each channel.

Marks: Opens a submenu with controls for showing, hiding, or resetting marks.

Reset Channel Size: Returns all open channels to their default screen spacing.

Teaching Mode: limits the functions listed in the right-click menu and Preferences windows 
to those commonly used in teaching.

Research Mode: expands the functions listed in the right-click menu and permits use of the 
Advanced page in the Preferences dialogue window.

Views: Allows the user to select any of the views of the Main window created on the 
Advanced page of the Preferences dialogue window. See Research Mode.

Window The Window menu allows the different windows used to display data to be selected.

 Figure 4-4: The LabScribe Window menu.

Main: Brings the Main window to the foreground. Also available from the LabScribe 
toolbar.

Analysis: Brings the Analysis window to the foreground. Also available from the 
LabScribe toolbar.

ScopeView: Brings the ScopeView window to the foreground. Also available from the 
LabScribe toolbar.

Journal: Brings the Journal to the foreground. Also available from the LabScribe toolbar.

Marks: Brings the Marks list to the foreground. Also available from the LabScribe toolbar.

Preview: Brings the Preview window to the foreground, where real time inputs into all 
open channels are displayed.

XY View: Brings the XY View window to the foreground. Also available from the 
LabScribe toolbar.

FFT (Spectrum): Brings the FFT window to the foreground. Also available from the 
LabScribe toolbar.
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Tools The Tools menu provides functions that can find and move specific data points to tables 
created in the Journal.

 Figure 4-5: The LabScribe Tools menu.

Add Data to Journal: Sends the calculated values for the selected Table Functions from the 
Analysis or ScopeView windows to the Journal.

Add Titles to Journal: Sends the titles of the calculated values for the selected Table 
Functions from the Analysis or ScopeView windows to the Journal.

Find Hardware: Identifies and initializes the computer’s connection to iWorx data acquisition 
device.

Find: Calls a dialogue box for programming the placement of cursors on data displayed in the 
Analysis or ScopeView windows.

Find Next: Finds the next data point in the file which meets the criteria set in the Find box.

Auto Find: Automatically finds each successive data point in the file that meets the criteria set 
in the Find dialogue box. Calculated values from the Table Functions selected in the Analysis 
window are automatically added to the Journal for each matching data point.

Auto Mark: Calls a list of functions that can automatically locate characteristic data points, 
like the LVEDP or QRS, in a data file displayed in the Analysis or ScopeView window.

Delete Block: Can be used in the Analysis window to delete the current block. Warning: This 
cannot be undone!

Down Sample: Used to downsample the data, This reduces the information in the file, and 
should be used with caution. Warning: This cannot be undone!

Settings The Settings menu contains functions to load and edit files containing preset recording and 
analysis parameters. Selecting a file from the list programs LabScribe to record data in a 
specified manner.

 Figure 4-6: The LabScribe Settings menu.
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Load Group: Loads a group of existing setting files. Each file contains the recording and 
analysis parameters needed in LabScribe to record a specific experiment or type of data.

Edit Group: Allows the user to edit existing settings files in a group, remove them from a 
group, or to add new ones to a group.

Test 1, Test 2, Test 3: Examples of the names given to the experimental settings in a group.

Help The Help menu provides links to information about the LabScribe software and hardware.

 Figure 4-7: The LabScribe Help menu.

Tip of the Day: Selecting this function displays a important bit of information about LabScribe 
and iWorx units

Help (Manual): Sends user to the on-line version of the LabScribe software manual. Also 
available from the toolbar.

iWorx on the Web: Takes the user to the iWorx home page.

About LabScribe: Displays version and copyright information pertaining to the LabScribe 
program.

Check for Updates: Checks the LabScribe.com website for the latest version of software.

Toolbars

Main toolbar

 Figure 4-8: The toolbar in the LabScribe Main window.

New: Opens a new file. Only one acquisition window may be open at a time.

Open: Opens a previously recorded file. 

Save: Saves data to the file currently open. 

Cut: Inside the LabScribe program, the Cut and Paste commands work only in the 
Journal. 

Copy: Copies the window in the foreground to the clipboard for pasting.

Paste: Pastes the contents of the clipboard to the Journal.
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Print: Prints the window in the foreground.

Help (Manual): Sends user to the on-line version of the LabScribe software manual.

Main: Brings the Main window to the foreground.

Analysis: Brings the Analysis window to the foreground.

ScopeView: Brings the ScopeView window to the foreground.

XY View: Brings the XY View window to the foreground.

FFT (Spectrum): Brings the FFT window to the foreground. 

Marks: Brings the marks list to the foreground. 

Journal: Brings the Journal to the foreground.

Stimulator Panel: Hides or displays the Stimulator toolbar.

Half Display Time; Reduces the time displayed on the screen by a factor of 1/2, each 
time the icon is clicked.

Double Display Time: Increases the time displayed on the screen by factor of 2, each 
time the icon is clicked.

2-Cursor Mode: Click icon to display two cursors on the data window. Time and voltage 
differences between the data points intersected by the cursors are measured.

1-Cursor Mode: Click icon to display one cursor on the data window. Absolute time and 
voltage from the beginning of the trace to the cursor are displayed.

Stimulator 
Toolbar

 Figure 4-9: The Stimulator Control Panel on the LabScribe Main window.

Amp: Amplitude of the stimulus pulse in Volts.

W: Width of the pulse in milliseconds (ms).

F: Frequency of stimulation in Hertz (Hz).

N: Number of pulses.

Apply: applies any changes to the stimulus protocol made through the Stimulator Toolbar. 
Clicking Apply while recording will send a stimulus pulse from the output. 

• In the Train and Step modes, only the Apply button is enabled.

• In the Constant mode, the Amp and the Apply button are enabled.
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Output 
Sequence 
Toolbar

The Output Sequence Toolbar is a drop-down list containing 
sequences of analog or digital outputs defined on the Output 
Sequence page of the Preferences dialogue window. Clicking the 
OutSeq button will fire the output sequence selected from the list. 
Selecting a new sequence in the drop-down list also automatically 
fires that sequence.

Dialogue Windows

Preferences 
for iWorx 
104/204/108 

There are five pages in the Preferences dialogue window for these iWorx units. Preferences 
for the iWorx 114/214/118 are covered on page 46.

 Figure 4-10: The pages of the Preferences dialogue window for the iWorx 104/108/204.

Sampling Page

 Figure 4-11: The Sampling page of the Preferences dialogue window for iWorx 104/108/204.

Sampling Speed: Sets the number of samples taken every second on each channel.

Display Time: Sets the time and the amount of data displayed on the screen 

Num Channels: Sets the number of channels displayed.

Device: Selects the device from which data will be collected.

Start: Selects the Start mode. Refer to the section on Triggering

Stop: Selects the Stop mode. Refer to the section on Triggering.

Chart: Sets the acquisition mode to Chart.

Scope: Sets the acquisition mode to Scope. 
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Channel 1-8 
Page

 Figure 4-12: The Channels page of the Preferences dialogue window for iWorx 104/108/204.

Enable: Makes the channel available for recording.

Channel Title: Title or Label assigned to the channel

Set Scale: Sets the maximum and minimum Y-axis values.

Calibration: Used to convert 2 raw data values to 2 corresponding calculated values, using a 
linear scale. For more information refer to the Units Conversion section.

Units: Name of the units to which the raw data has been converted.

Stimulator Page

 Figure 4-13: The Stimulator page of the Preferences dialogue window for iWorx 104/108/204.

Off: Turn the stimulator off.

Pulse: Enables Pulse mode.

Constant Voltage: Set Stimulator to put out a constant voltage.

Refer to the Stimulator section for more information on stimulator parameters.

Functions Page

 Figure 4-14: The Periodic section of the Preferences dialogue window for iWorx 104/108/204.
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For on-line Periodic functions, like rate and frequency, there are Threshold and Tolerance 
levels that the raw data must meet or exceed for these functions to accurately determine the 
values of the computed parameters. Threshold and Tolerance levels can be adjusted on this 
page. Off-line, the parameter known as Baseline Tracking can be set to track the speed at 
which periodic changes in the baseline occur.

 Figure 4-15: The Integral section of the Preferences dialogue window for iWorx 104/108/204.

For another set of computer functions, Integrals, the number of data points used to determine 
the baseline and the time interval at which the baseline is reset can be programmed.

Reset every (sec): Used to set the Integral reset time.

Use First “N” points as zero: Removes the effects of a DC baseline when calculating an 
Integral. This feature is useful in applications where the baseline is difficult to set to zero.

Network Page

 Figure 4-16: The Networks section of the Preferences dialogue window.

Multicasting: The Multicasting version of LabScribe transmits the acquired data over a peer 
to peer network.

Host Group IP address: Should be the same for the transmitting IWorx unit and the receiving 
iWorx unit(s).

Host Group Port: The port at which the Host transmits.

Time to Live: The number retransmission or “hops” of data packets allowed. Setting the 
number to 1 ensures that the multicasting data does not “leak” out of the LAN and cause 
network congestion.
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Preferences 
for iWorx 
114/214/118

There are six pages in the Preferences dialogue box. Preferences for the iWorx 104/204/108 
are covered on page 43.

 Figure 4-17: The pages of the Preferences dialogue window for iWorx 114/118/214.

Channels Page The preferences that can be set for all channels include:

Sampling Speed: Sets the number of samples taken every second on each channel.

Display Time: Sets the time and the amount of data displayed on the screen 

Num Channels: Sets the number of channels displayed on the Main window.

The preferences that can be set for each individual channel include:

Channel Title: Edits the title of each channel to better identify the parameter recorded.

Mode: Sets the record or the display mode of the channel. Channels 1 and 2 on the iWorx 214 
(Channel 1 only on the 114) have record modes which allow either the bioamplifiers to be 
activated with a bandpass filter (0.03-150Hz, 0.3-35 Hz, or 3-10KHz) or the BNC input to be 
activated for recording signals from other devices with analog outputs.

 Figure 4-18: The Channels page of the Preferences dialogue window for iWorx 114/118/214.

Function: Selects either Raw Data or one of the many available calculated values to be 
displayed on the channel.

Set Scale: Sets the maximum and minimum Y-axis values.
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Calibration: Used to convert 2 raw data values to 2 corresponding calculated values, using a 
linear scale. For more information refer to the Units Conversion section

Units: Name of the units to which the raw data has been converted.

Sampling Page

 Figure 4-19: The Sampling page of the Preferences dialogue window for iWorx 114/118/214.

Device: Selects the device from which data will be collected.

Start: Selects the Start mode. Refer to the section on Triggering

Stop: Selects the Stop mode. Refer to the section on Triggering.

Chart: Sets the acquisition mode to Chart.

Scope: Sets the acquisition mode to Scope. For Scope mode, recordings can be made in 
Repetitive or Multiple Sweep mode, where the recording stops after “N” sweeps. The Delay 
between Sweeps can also be specified in case of Multiple Sweep mode.

Stimulator Page Used to setup the Stimulator(s) on the iWorx 114/214/118. There are 5 modes: Off, Pulses, 
Trains, Constant, and Step. The available parameters in each of these modes can be preset 
and made part of a settings file. 

Refer to the Stimulator section of the Input/Output chapter for information on the 
programming of the stimulator.

Functions Page

 Figure 4-20: The Periodic section of the Preferences dialogue window for iWorx 114/118/214.
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For on-line Periodic functions, like rate and frequency, there are Threshold and Tolerance 
levels that the raw data must meet or exceed for these functions to accurately determine the 
values of the computed parameters. Threshold and Tolerance levels can be adjusted on this 
page. Off-line, the parameter known as Baseline Tracking can be set to track the speed at 
which periodic changes in the baseline occur.

 Figure 4-21: The Integral section of the Preferences dialogue window for iWorx 114/118/214.

For another set of computer functions, Integrals, the number of data points used to determine 
the baseline and the time interval at which the baseline is reset can be programmed.

Reset every (sec): Used to set the Integral reset time.

Use First “N” points as zero: Removes the effects of a DC baseline when calculating an 
Integral. This feature is useful in applications where the baseline is difficult to set to zero.

Output 
Sequences Page

Refer to the Digital Inputs and Digital Outputs sections of the Inputs/Outputs chapter for 
information on configuring this page.

Advanced Page

 Figure 4-22: The Advanced page of the Preferences dialogue window for iWorx 114/118/214.
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In the Views section of this page, different combinations of data channels can be programmed 
to be displayed when selected from the View menu on the Main window.

In the Events section of this page, an event occurring on a data channel can be programmed 
as the trigger for an Output Sequence when the amplitude of the event is between upper and 
lower limits.

The default format for exporting data files can also be selected on this page.
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Chapter 5: Analysis

Overview
Today’s analog to digital converters make acquiring data very easy. The challenge to all users 

is to extract meaning from the mountains of recorded data in order to generate conclusions, 
reports, and Nobel Prizes. This process is called analysis. 

Built into the LabScribe data recording software is a powerful array of data analysis tools. The 
variety of tools available strike a balance between the straightforward, general operations that 
everyone uses and the vertical, complex routines that only YOU use. So, LabScribe is a 
powerful analytical tool that can go to work on data right away, or be customized to execute very 
specific, complex analysis routines. 

Analysis in LabScribe is divided into five types or kinds. Each kind addresses specific 
analytical requirements. The following sections of this chapter explain how each type is used.

Analyses of the First Kind: Wave-to-Wave Transforms
Analytical functions of this kind take ALL of the data in a channel and apply a transform, which 

converts the entire waveform described by the data points into a completely new wave, that is 
displayed on a different channel. Examples of this kind of analysis would be the first derivative 
or the integral. 

Currently there are 27 functions of the First Kind, or Wave-to-Wave Transforms, included in 
the LabScribe program. These functions can only be accomplished on the Main window. They 
are called from the right-click menu and can be used on-line or off-line. When used on-line, 
the functions can operate at the top acquisition rate of the program, 100,000 samples per 
second.

On the right-click menu, the transforms are organized into groups. The functions within a 
group have similar setup requirements and are usually located in a sub menu. While the list of 
available functions is always expanding, LabScribe V1.8 includes the following groups: 
Periodic, Integral, Derivatives, Channel Math, Filter, Power, Spirometry, Cardiac, EEG, and 
Gain Telegraph. Each group is discussed below.

Before beginning to explain the various First Kind functions, it is appropriate to ask: “Where 
does the RAW DATA for a wave-to-wave analysis come from?” It is a question that is appropriate 
for all of the First Kind functions. By default, calculated channels (channels displaying wave-to-
wave transforms) always use the channel immediately above them as the raw data channel. For 
example, if the Rate function is selected on Channel 2, the electrocardiogram equipment or 
pulse sensor should be connected to Channel 1. Likewise, by default, an integral set on Channel 
4 expects the raw data input to come from Channel 3.

It is possible to select another channel, besides the one above the calculated channel, as the 
source of raw data. To select the raw data channel for a function, highlight the Set Raw Channel 
item at the bottom of the channel right-click menu. This opens a submenu. From the submenu, 
select the channel that is the source of raw data for the calculated function. For example, 
opening the right-click menu for Channel 2, and setting the Set Raw Ch to Channel 3, causes 
any calculated functions called on Channel 2 to look at Channel 3 (the channel below) for its 
source of raw data as opposed to the default (Channel 1, the channel above).
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The settings for any of these wave-wave analysis functions are available on the Functions 
page of the Preferences dialogue window. These settings are factory set to include most 
biological signals; but, they may be modified for any signal type and stored in Settings files.

Setup 
Transform

Whether calculated functions are performed on-line (in real time) or off-line (after recording 
has stopped), their setup is the same. To set up a calculated (wave-to-wave transform) channel:

•Right- click in the display area of the channel being set as a calculated function. 
A menu of function choices appears 

•Highlight and select one of the functions.

•By default the channel will look to the channel above for its raw data. If you 
require a different channel to supply the raw data, select it from the Set Raw 
Channel item at the bottom of the right-click menu. 

•Click the Start button. Click AutoScale for the raw data channel; then, click 
AutoScale for the calculated channel. 

The calculated function will then be displayed; no other setup is required. 
Specific setups for the different groups of functions are described below.

 Figure 5-1: The Right-Click for a channel displayed on the LabScribe Main window.

Periodic Periodic functions operate on cyclic data to produce a graphical representation of how the 
Rate, Frequency, Period, Cycle Maximum, Cycle Minimum, Cycle Mean, or RMS (Root Mean 
Square) vary with time. The program calculates these parameters with each cycle of the signal 
and displays the calculation on the screen. 

Threshold To make these types of calculations on each cycle, the software must have a way of defining a 
cycle of data. As data is collected on-line or processed off-line, the LabScribe program begins 
the calculation by using the AutoScale feature to determine the Max and Min values in a given 
screen of data. Then, the program uses a Threshold value to find points on the recording where 
the trace repeatedly crosses the threshold with a positive slope. The control for the Threshold 
level can be found on the Functions page of the Preferences dialogue window, in the Periodic 
section. The Threshold level is set at X% of maximum value in any given screen of data. By 
default, X% is set to 60%, which is adequate for almost all biological signals. The Threshold 
percentage can be changed by entering a different number in its box. Finally, the program 
defines the time between the points, where the recording repeatedly crosses the threshold line 
with a positive slope, as a Period (Figure 5-2 on page 52).
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 Figure 5-2: The Periodic section of the Preferences dialogue window.

Tolerance A second Periodic control known as Tolerance, or hysteresis, is present on the Functions 
page of the Preferences dialogue window. Tolerance is used to reduce false triggering due to 
noise in the signal. By default the tolerance is set at 3%, if the threshold is set at 60% then the 
signal has to cross from below 58.5% (60 - 3/2) to above 61.5% (60 + 3/2) for a threshold 
crossing to be detected. The maximum value between two threshold crossings is taken to be the 
peak, and adjacent peaks are used to calculate the periodic functions.

Exercise To see Threshold and Tolerance in use, record some pulse data using the Tutorial setting 
from one of the Settings groups. Apply the Rate function to the channel below the recording 
channel. 

The Rate function must be able to ignore the second small wave associated with each larger 
pulse wave; otherwise, it will report a rate that is twice what it should be. Using the Rate 
function on an ECG would mean that Threshold and Tolerance should be set so that only one 
wave of the three separate and distinct waves per beat can be counted. 

Baseline 
Tracking

The next challenge to programming a Periodic calculation is to exclude the baseline drift. 

The most commonly observed signal in the Periodic category is blood pressure. Setting 
thresholds on this type of data is useful only if the diastolic value does not change dramatically 
over the course of the experiment. The program could be made to compensate for such changes 
by clicking the AutoScale button while recording. If the observer wants to look at the entire 
range of pressures while following rate, it is not convenient to use AutoScale repeatedly. 

LabScribe handles drift on the baseline by using a Baseline Tracking function, which is also 
located in the Periodic section of the Functions page in the Preferences dialogue window.

Baseline Tracking applies a HIGH PASS filter, that has adjustable strength, to the data before 
LabScribe determines the Rate or any other Periodic function. HIGH PASS filters and AC 
COUPLING can constrain the signal around zero. In our example of measuring blood pressure, 
Periodic functions can be done without complications from changes in the diastolic value. Using 
Baseline Tracking while using Rate or any other Periodic function means that the data is faith-
fully followed, even through dramatic changes of the baseline. 
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Setup If baseline shifts are causing a loss of a Periodic function online proceed to the Functions 
page in the Preferences dialogue window. To use Baseline Tracking, advance the Baseline 
Tracking slide bar about 10% from the left side. Return to the Main window and check the 
recording. If the Periodic function is still being dropped online, increase the amount of filtering 
by moving the Baseline Tracking slide bar another 10%.

Activating 
Periodic 
Transforms

All Periodic functions are selected in the same manner. To use any of these 
functions, right-click on the display area of the channel where the function is 
to be displayed. Select Periodic from the right-click menu and a submenu 
appears. Select one of the functions in the submenu. By default, raw data will 
be collected on the channel immediately above the calculated channel 
(Channel 1 for calculated Channel 2, Channel 3 for calculated Channel 4, 
etc.). Use the Set Raw Channel function at the bottom of the right-click menu 
for the calculated channel to select a different channel as the source of raw 

data. Click Start in the Main window to begin recording. AutoScale the raw data, then 
AutoScale the calculated channel. No other setup is required.

The functions in the Periodic submenu are:

Rate: The program takes the period in seconds and divides this value into 60. The result is a 
rate, which is expressed in beats per minute

Frequency: The program takes the period in seconds and divides this value into 1. The result 
is a frequency, which is expressed in Hz or cycles per second.

Period: The program takes the Period for each cycle.

Min: The program examines all of the points in the current period and finds the lowest value.

Max: The program examines all of the points in the current period and finds the highest value.

Mean: The program examines all of the points in the current period and finds the average of 
all values.

RMS: The program examines all of the points in the current period and finds the Root Mean 
Square value for all points

Integral The integral is the area under the curve. The Integral function, as executed by the LabScribe 
software, calculates a continuous sum of all the data points on a given channel and plots the 
running total. Data points with values above zero make the Integral larger, those with values 
less than zero make the Integral smaller. To successfully complete the calculation of the 
Integral, the location of the zero-line and the portion of the data being examined need to be 
known. 

Setting the baseline of the raw data channel to zero is the more important of the two require-
ments since this function defines the difference between positive and negative areas of the 
recording. If the baseline of the raw data record is in the positive range of amplitudes, then the 
Integral will have a positive slope, even though no signal is present. Conversely, if the baseline 
of the raw data is in the negative range, the Integral will have a negative slope.

The portion of raw data to be integrated should be a manageable size. If too much raw data is 
integrated, navigating through the data and measuring changes in the Integral value is more 
difficult. 

There are two parameters that can be set to control the Integral functions. These are found in 
the Integral section on the Functions page of the Preferences dialogue window. All these 
parameters are involved in setting or maintaining the zero-line for the Integral calculation. 
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Zero As mentioned above, the Integral function adds the amplitudes of successive data points and 
plots the total. The problem is determining where the zero-line is located. LabScribe and most 
other data programs take the value zero volts as the zero-line. If real units, such as grams or 
mmHg are used, the LabScribe software will take the zero units value as zero. 

LabScribe also has a Use First “Number” points as zero option. When the box next to this 
function is checked, the first “Number” of data points collected are averaged and used by the 
program as zero. This feature is particularly useful when trying to integrate signals that are 
difficult to zero manually. 

An example of the application of this feature is illustrated in Figure 5-3 on page 54. The output 
of a respiratory flow sensor is the raw data displayed on the upper channel in each window; the 
lower channel in each window is the integral of the upper channel, or the volume flowing through 
the sensor. 

In this example, the setting of zero is critical because any offset of the raw data from zero will 
be taken as a flow and, subsequently, be interpreted as a volume. Two examples of the respi-
ratory integral are shown. In each case the flow sensor has a small, but stable offset. In the 
example on the left, the integral shows constant increase in volume, as the flow is constant. In 
the record on the right, where the Use First “Number” points as zero option is used, the initial 
flow is constant and is set to zero, so the initial volume is zero. When the flow increases to a 
level above the “effective” zero-line, the volume increases on the integral channel. 

 Figure 5-3: Integral without Zero.

 Figure 5-4: Integral with Zero

The Reset control in the Integral area on the Functions page of the Preferences dialogue 
window determines when the Integral or running count will reset itself to zero. This option 
allows the Integral to reset itself after a preset time. This is a useful option if the data being 
integrated contains artifacts that move the Integral artificially up or down. The Reset function 
keeps the Integral trace in the field of view. In the respiration example, if inhaled air is at 20oC 
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and exhaled air is closer to body temperature, then exhaled air has a larger volume. Since the 
subject exhales more than he or she inhales, the integral record with have a slow upward drift. 
Resetting the trace periodically will return it to zero.

Activating 
Integral 
Functions

Both Integral functions are selected in the same manner. To use either of 
these functions, right-click on the display area of the channel where the 
function is to be displayed. Select Integral from the right-click menu and a 

submenu appears. Select one of the functions in the submenu.

By default, raw data will be collected on the channel immediately above the calculated channel 
(Channel 1 for calculated Channel 2, Channel 3 for calculated Channel 4, etc.). Use the Set 
Raw Channel function at the bottom of the right-click menu for the calculated channel to select 
a different channel as the source of raw data. 

Click Start in the Main window to begin recording. AutoScale the raw data, then AutoScale 
the calculated channel. No other setup is required.

The functions in the Integral submenu are:

Integral: As mentioned above, the integral function adds the value of successive data points 
and plots the total. 

Abs.Integral: The Absolute Value of the Integral, as the name implies, makes all values of 
the integral positive and plots the running total. The Abs. Integral is used for analysis of cyclic 
data such as unit action potentials or EMG data. The integral value is programmed to reset after 
each cycle.

Derivative The Derivative function calculates the derivative at each point in the raw data, and then 
displays it on the calculated channel. On the channel where the Derivative is displayed, the 
units are changed to the units of the raw data channel/second. On a channel programmed to 
display the Second Derivative, the units are the units of the raw data channel/second/second.

Activating 
Derivative 
Function

To use either of the Derivative functions, right-click on the display area of the 
channel where the function is to be displayed. Select Derivative from the 
right-click menu and a submenu appears. Select one of the functions in the 

submenu. By default, raw data will be collected on the channel immediately above the calcu-
lated channel (Channel 1 for calculated Channel 2, Channel 3 for calculated Channel 4, etc.). 
Use the Set Raw Channel function at the bottom of the right-click menu for the calculated 
channel to select a different channel as the source of raw data.Click Start in the Main window to 
begin recording. AutoScale the raw data, then AutoScale the calculated channel. No other 
setup is required.

The functions in the Derivative submenu are:

First: Takes the first derivative at each data point in the raw data and plots it on the calculated 
channel

Second: Takes the second derivative at each data point in the raw data and plots it on the 
calculated channel

Channel 
Math

The Channel Math function applies a user-defined function to points from raw data channels 
and displays the output on a calculated channel. Each raw data channel can be a term in the 
user-defined expression. 
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For example, if the Channel Math function was selected on Channel 4. The following function 
could be programmed: Ch4 = Ch1/Ch2.

 Figure 5-5: The Channel Math dialogue window from the channel right-click menu.

The result displayed on Channel 4 is every Channel 1 data point divided by the corresponding 
Channel 2 data point. A full range of trig and log functions, as well as the common mathe-
matical operators, are available in the Channel Arithmetic dialogue window. The unit name for 
the calculated value can be specified in a box. There is also a Check Expression feature, which 
will check for errors like unclosed parentheses or division by zero. Since division by zero is a 
possible occurrence even in legitimate expressions, the program substitutes the last calculated 
value for the quotient, if division by zero is attempted.

Activating 
Channel Math

To use the Channel Math function, right-click on the display area of the channel where the 
function is to be displayed. Select Channel Math from the right-click menu and program the 
expression to be displayed on the selected channel. Set units if desired, and click OK.

Filter Each channel has its own digital Filter that can be used on-line or off-line. When used on-line, 
the program applies an 8-pole Butterworth filter, which reduces noise effectively on most 
smoothly varying signals. However, sharp voltage steps, like the ones used in a voltage clamp 
application, are not well tolerated by the on-line version of the digital filter. The solution for 
filtering sharp changes in voltage is to use a different type of filter off-line. When the Stop 
button is clicked, LabScribe recalculates the entire record as it applies a 201storder raised-
cosine FIR filter.

To use the Filter function, right-click on the display area of the channel where the signal to 
be filtered is displayed. If you intend to display the filtered data on the same channel as the raw 
data, go to the Set Raw Channel function at the bottom of the right-click menu, and set the 
channel to take the raw data from itself. Select Filter from the right-click menu. In the Set 
Filter window, drag the boundaries of the filter to create the desired filter. Click OK. No other 
setup is required.
  56



. .
 

 Figure 5-6: The digital (software) Filter dialogue window from the channel right-click menu.

The graphic interface in the Set Filter window is straight forward. The BLUE area corresponds 
to the frequencies that are passed, and the WHITE area corresponds to frequencies that are 
rejected. To remove high frequencies from the signal, click on the right boundary of the BLUE 
area and drag this boundary to the left. To remove low frequencies from the signal, click on the 
left boundary of the BLUE area and drag this boundary to the right. After clicking and dragging a 
boundary, it can be placed more accurately with the arrow keys on the keyboard. Boundaries 
can be placed in configurations that create High Pass, Low Pass, Band Pass (Figure 5-6 on 
page 57), or Notch filters.

Notice that the Filter is subject to the Nyquist limitation of frequency. The maximum frequency 
in the Set Filter window is exactly half of the sample frequency.

Power The Power function performs a Fast Fourier Transform (FFT) on data in the selected channel 
and returns the average Power in the frequency band selected. 

 Figure 5-7: The Power dialogue window from the channel right-click menu.

In LabScribe V1.8, this function works only off-line. The graphic interface in the Power 
dialogue window is similar to the one in the Set Filter dialogue window. The band of frequencies 
selected from the Power dialogue window are not filtered, but they are subjected to a FFT 
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whose output is known as a Power number. In addition to specifying the range of frequencies 
transformed, the frequency resolution can be selected. The higher the frequency resolution, the 
more data points required to compute the FFT. Therefore, at slow sampling rates, higher 
frequency resolutions may require the processing of more data points from longer recording 
periods

Spirometry The Spirometry function is a specialized version of the integral function for use with the iWorx 
spirometer. This transducer, which measures respiratory volumes, is a sensitive air flow sensor. 
LabScribe integrates the flow values measured by the sensor and displays volume. The settings 
for this integration are specifically designed for volume calculations. By selecting the Volume 
function in the Spirometry sub-menu, a couple of required settings are installed by the program. 

LabScribe will take the first 50 data points, average them together and use the result to set the 
zero-line of the Volume channel. This is necessary because the output of the air flow sensor is 
always offset; and any offset would cause the Volume channel to display a volume change, 
even though there was no air flowing through the sensor.

The Volume integral also resets every 30 seconds. During spirometry experiments, the volume 
trace drifts upward because the volume of exhaled air is larger than the volume of inhaled air. 
Cooler inhaled air at room temperature occupies less volume than warmer exhaled air. The 
Volume integral will drift up and out of view, as it reports correct values, unless a periodic reset 
is employed. 

Activating 
Volume Function

To use the Volume function, right-click on the display area of the channel 
where the Volume is to be displayed. Select Spirometry from the right-click 
menu and a submenu appears. Select Volume in the submenu. By default, 
raw data will be collected on the channel immediately above the calculated 

channel (Channel 1 for calculated Channel 2, Channel 3 for calculated Channel 4, etc.). Use the 
Set Raw Channel function at the bottom of the right-click menu for the calculated channel to 
select a different channel as the source of raw data.

To accurately convert the flow data of the sensor to volumes (in liters), the calibration value for 
the air flow sensor must be entered into the program. The default calibration value used by the 
program is 0.150 Vs/liter. The actual calibration value of the flow sensor being used is written 
on a label on the side of the flow sensor unit. To convert the flow data to volumes, open the 
Spirometry submenu and select Calibrate. The Spirometry Calibration dialogue window 
appears. Enter the calibration value printed on the side of the air flow sensor into the box on the 
calibration window. Enter the value exactly as it is written.  Click OK.

Click Start in the Main window to begin recording. AutoScale the raw data (Air Flow) channel, 
then AutoScale the Volume channel. No other setup is required.

Cardiac The Cardiac functions are specifically used for the analysis of electrocardiograms (ECG). 
Four of the Cardiac functions calculate Leads: III, aVL, aVF and aVR from the recordings of 
Lead I on Channel 1 and Lead II on Channel 2. LabScribe can be programmed to do these 
calculations because all the points of view in a 6-lead ECG are in the same plane (frontal) of the 
body, and each lead can be considered as a vector. So, if any two of limb leads are recorded, 
the other four leads can be calculated from them. 

The Cardiac submenu also includes four other functions. The Cardiac Angle function is 
available, which can calculate the vector of the cardiac depolarization that passes through the 
interventricular septum. Three Power functions, which are special cases of the general power 
function described earlier, are also available.These three power functions are useful for heart 
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rate variability (HRV) analysis. Low Frequency (LF) Power (0.04-0.15 Hz), High Frequency 
(HF) Power ((0.18-0.4 Hz) and Total Power are each calculated from the transformation of a 
tachogram of an ECG on one of the raw data channels. 

Activating 
Cardiac 
Functions

To use the Cardiac functions, right-click on the display area of the 
channel where the function is to be displayed. Select Cardiac from 
the right-click menu and a submenu appears. Select one of the 
functions in the submenu. To calculate Leads III, aVL, aVF or aVR 
automatically, Leads I and II must be recorded on Channels 1 and 
2, respectively. Angle and the HRV Power functions are usually 
taken from the Lead II ECG channel since it is normally the one with 
largest QRS complexes. Use the Set Raw Channel function at the 
bottom of the right-click menu to select the raw data source for the 
calculated channel. Click Start in the Main window to begin 

recording. AutoScale the raw data, then AutoScale the calculated channel. No other setup is 
required.

EEG The EEG function is another specialized case of the Power function. In this function, a preset 
frequency band is available for each component of the EEG: Alpha, Beta, Theta, and Delta. For 
each selected band, LabScribe calculates the average Power in the band and displays the value 
against time. These are beneficial functions to use when teaching students, because they can 
clearly see the effect that behavior has on components of the EEG.

Activating EEG 
Functions

To use the EEG functions, right-click on the display area of the channel 
where the function is to be displayed. Select EEG from the right-click menu 
and a submenu appears. Select one of the EEG frequency bands from the 
submenu. Use the Set Raw Channel function at the bottom of the right-click 
menu to select the raw data source for the calculated channel.

Click Start in the Main window to begin recording. AutoScale the raw data on the EEG 
channel, then Autoscale the calculated channel. No other set up is required.

Stimulator 
Display

The Stimulator Dspl (Display) function is really a control that permits a representation of the 
stimulator output to be displayed on the data recording. This display control can be used on-line 
or off-line. Two output displays, Out1 and Out2, are available. Out1 functions on all iWorx 
hardware that have a stimulator. Out2 functions only when used on the iWorx 118, which has 
two independent stimulator outputs.

Because of the way the Stimulator Dspl control is programmed in LabScribe, the stimulus 
waveform can be shown on any one of the recording channels without losing the capability of 
that channel to record data. On a specific channel, the user can “toggle” between displays of the 
data and the stimulus records.

Activating 
Stimulator 
Display

To use the Stimulator Dspl, right-click on the display area of 
the channel where the stimulator output will be shown. Select 
Stimulator Dspl from the right-click menu, and a submenu 

appears. Select one of the Outputs from the submenu. Click Start in the Main window to begin 
recording. AutoScale the channels that need to be reset. To return the stimulator display 
channel to showing recorded data, select Raw Data in the right-click menu of that channel.
Chapter 1: Analysis 59



Gain 
Telegraph

The Gain Telegraph function is slightly different from the 
other functions in the right-click menu. Some amplifiers have 
an additional output that sends a calibration signal to the data 
recording unit. This calibration signal relays information 
about the gain settings of the external amplifier. This infor-
mation permits the recording program to re-calibrate the 
amplifier output in the correct units regardless of the gain set 
on the amplifier. The list of amplifiers supported by this 
feature can be found in the Gain Telegraph submenu. 

Using Gain 
Telegraph

Connect the analog output of the supported amplifier to any input channel. For this example, 
assume this is Channel 1. Next, connect the gain telegraph output of the amplifier to any input 
channel. For this example, assume this is Channel 2. 

Open the right-click menu on the analog input channel (Ch 1), and select the supported 
amplifier from the Gain Telegraph submenu. Next, set Raw Data Channel on the analog input 
channel (Ch 1) to the channel (CH 2) receiving the gain telegraph output of the amplifier.

Wavelet

 Figure 5-8: The Wavelet dialogue window in the channel right-click menu.

The Wavelet function performs a Wavelet Transform (DWT) on data in the selected channel 
and returns the DWT at the level selected. In LabScribe V1.8, this function works only off-line.
  60



. .
 

Analyses of the Second Kind: Digested Data

The functions in this kind of analysis take a group of data points, selected by the user, and 
"digests" them into a single value. These values can be saved to a Journal within LabScribe, or 
exported to other programs. This kind of analysis can proceed in the Analysis window or the 
ScopeView window. There are currently 31 functions available in the LabScribe program to do 
this kind of analysis. Some of the functions are: Mean, Max, or Max-Min.

While the use of “second kind” functions is the same in both windows, (Analysis and 
ScopeView) the set-up and layout is slightly different from window to window. Each window and 
the use of second kind functions are described below.

Analysis 
Window 
Setup

The Analysis window (see Figure 5-9 on page 62) is used to display and perform calculations 
on selected pieces of data captured from the Main window. The data used in the Analysis 
window is defined by placing the cursors on either side of the data while it is displayed in the 
Main window. The data is then captured by either clicking the Analysis icon on the LabScribe 
toolbar or selecting Analysis from the Windows menu. Data from all channels within the 
selected area is displayed in the Analysis window. 

The channels containing the data of interest can be chosen for display by selecting their 
names from the Display Channels list on the left side of the Analysis window. Use the standard 
Windows commands, SHIFT-CLICK and CONTROL-CLICK, to select the channels. The selected 
channels are autoscaled and tiled in the data display area, one channel beneath the other. 
Clicking the Stacked radio box will overlay the selected channels in the Analysis window. Since 
AutoScale is always enabled in the Analysis window, the stacked channels will be autoscaled 
on the same Y-axis. 

Many of the same tools in the Main window are also available in the Analysis window. These 
include: Display Time controls; Marks, which are the same as the ones positioned in the Main 
window; Dual Cursor mode (Single Cursor mode is unavailable); scroll bars to fine tune the 
area of data upon which the selected functions will operate; and Block-Up and Block-Down 
buttons on either end of the scroll bar that provide shortcuts for scrolling to the next or previous 
block.

Data in the Analysis window can be operated upon by the functions in the table on the left 
side on the Analysis window. Again, the Dual Cursors are positioned on the left and right 
edges of the data to be analyzed. LabScribe will immediately calculate and display the values 
for the selected parameters in the Calculated Value Display area at the top of the Analysis 
window. Calculations can be performed on only one channel at a time. So, the channel to be 
measured needs to be selected from the Value from Channel pop-down menu in the upper left 
corner of the Analysis window. The precision of the calculations performed is adjustable from 
the Precision pop down below the Value from Channel pop-down menu. 

There are 31 analytical functions available in the Table Functions list in the lower left side of 
the Analysis window. The functions are described below. The values listed in the Calculated 
Value Display area can be sent to the Journal for formatting and inclusion in reports. To do 
this, right-click in the display area in the Analysis window, and select Add Title or Add Data 
to Jrnl. These commands are also accessible from the Tools menu.

The Analysis window can also be copied, printed, or exported to ASCII, .png, or .bmp format 
documents.
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 Figure 5-9: The LabScribe Analysis window.

Analysis 
Window 
Components

Display 
Channels List

The Display Channels list allows the user to pick which channels to display in the Analysis 
window. Clicking on a channel name selects the channel and deselects any other channel that 
was previously selected. Multiple channels can be selected using the standard Windows 
commands, SHIFT-CLICK and CONTROL-CLICK.

Table Functions 
List

The functions selected in the Table Functions list determine the calculations performed on 
the data points between the two cursors in the Analysis window. These analyses can be 
performed only on one channel at a time. The results of the selected calculations are displayed 
in the Calculated Value Display area at the top of the Analysis window. 

Value from 
Channel List

The Analysis window can only operate on the data points from one channel at a time. Select 
the channel to be analyzed from the Value from Channel list in the upper left corner of the 
Analysis window.

Tiled or Stacked 
Display

By default, the channels selected for display are presented in Tiled mode. Each channel is 
displayed in its own area, as they are shown in the Main window. By clicking the Stacked box in 
the left margin of the Analysis window, selected waveforms can be overlaid on the same set of 
axes.
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Right-Click 
Menu in the 
Analysis Window

Right-click in the display area of the Analysis window to bring up a menu like the one in 
Figure 5-10 on page 63. Selecting Add Title to Journal sends the names of the analyses 
(calculations) being performed (and displayed at the top of the Analysis window) to the 
Journal. Selecting Add Data to Journal sends the calculated values from these analyses to the 
Journal. The right-click menu also gives the user the option to Zoom In or Zoom Out to refine 
the selection. The Zoom In function will expand the area between the cursors to full screen. 
When the Zoom Out function is used, the original screen of the Analysis window is positioned 
in the middle of a 2X larger data set. So, for each click of the Zoom Out function, the time 
displayed on the window is two times longer.

 Figure 5-10: The Analysis window right-click menu.

The Table Functions are the same for the Analysis window and ScopeView windows and are 
described after the ScopeView setup.

ScopeView 
Window 
Setup

The ScopeView window (see Figure 5-11 on page 64) is used to display and perform calcula-
tions on Sweeps of data recorded on the Main window while it is configured in Scope mode. In 
the ScopeView window, DIFFERENT time segments (or sweeps) of data from the SAME 
channel are displayed. This differs from the Analysis window where the SAME time segment of 
data from ALL channels is displayed. For a discussion of sweeps and acquisition in the Scope 
mode, see the Scope section of Chapter 3: Acquisition.

To enter the ScopeView window, click the ScopeView icon on the LabScribe toolbar or select 
ScopeView from the Window menu. All sweeps from the selected channel are displayed in the 
ScopeView window. Sweeps of interest can be selected in the Display Sweeps list on the left 
side of the ScopeView window. Use the standard Windows commands, SHIFT-CLICK and 
CONTROL-CLICK. The selected sweeps are autoscaled and tiled in the data display area, one 
sweep beneath the other. Clicking the Stacked radio box will overlay the selected sweeps in the 
ScopeView window. Since AutoScale is always enabled in the ScopeView window, the stacked 
sweeps will be autoscaled on the same Y-axis. At the bottom of the ScopeView window, the 
average of all selected sweeps is displayed

Many of the same tools in the Main window are also available in the ScopeView window. 
These include: Display Time controls; Marks, which are the same as the ones positioned in the 
Main window; Dual Cursor mode (Single Cursor mode is unavailable); and scroll bars to fine 
tune the area of data upon which the selected functions will operate.

Data in the ScopeView window can be operated upon by the functions in the table on the left 
side of the ScopeView window. Again, the Dual Cursors are positioned on the left and right 
edges of the data to be analyzed. LabScribe will immediately calculate and display values for 
the selected parameters in the Calculated Value Display area at the top of the ScopeView 
window. Calculations can be performed on only one sweep at a time. So, the sweep to be 
measured needs to be selected from the Value from... pop-down menu in the upper left corner 
of the ScopeView window. The precision of the calculations performed is adjustable from the 
Precision pop down below the Value from... pop-down menu. 
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 Figure 5-11: The LabScribe ScopeView window.

There are 31 analytical functions available in the Table Functions list in the lower left side of 
the ScopeView window. The functions are the same as the ones offered in the Analysis 
window. There are two rows of calculated values in the Calculated Value Display area. The 
first row contains the values from the selected sweep or block listed in the Value from... menu. 
The second row has the average of the calculated values from all the sweeps displayed in the 
ScopeView window. These values can be sent to the Journal for formatting and inclusion in 
reports by right-clicking in the display area in the ScopeView window and selecting Add Title 
or Add Data to Jrnl. These commands are also accessible from the Tools menu. 

The ScopeView window can be copied, printed, or exported to ASCII, .png, or .bmp format 
documents.

ScopeView 
Window 
Components

Display Sweeps 
List

The Display Sweeps list allows the user to pick which Sweeps to display in the ScopeView 
window. Clicking on a sweep name selects the sweep and deselects any other sweeps that were 
previously selected. Multiple sweeps can be selected using the standard Windows commands, 
SHIFT-CLICK and CONTROL-CLICK.

Table Functions 
List

The functions selected in the Table Functions list determine the calculations performed on 
the data points between the two cursors in the ScopeView window. These analyses can be 
performed only on one sweep at a time. The results of the selected calculations are displayed in 
the Calculated Value Display area at the top of the ScopeView window. 

Value from 
Sweep List

The ScopeView window can only operate on the data points from one channel at a time. 
Select the channel to be analyzed from the Value from... pop-down menu in the upper left 
corner of the ScopeView window.
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Tiled or Stacked 
Display

By default, the sweeps selected for display are presented in Tiled mode. Each sweep is 
displayed in its own area. By clicking the Stacked box in the left margin of the ScopeView 
window, selected sweeps can be overlaid on the same set of axes.

Right-Click 
Menu in the 
ScopeView 
Window

Right-click in the display area of the ScopeView window to bring up a menu like the one in 
Figure 5-12 on page 65. Selecting Add Title to Journal sends the names of the analyses 
(calculations) being performed (and displayed at the top of the ScopeView window) to the 
Journal. Selecting Add Data to Journal sends the calculated values from these analyses to the 
Journal. The right-click menu also gives the user the option to Zoom In or Zoom Out to refine 
the selection. As before, cursors are used to determine the portions of the data to be zoomed to 
full screen. The Zoom In function will expand the area between the cursors to full screen. When 
the Zoom Out function is used, the original screen of the ScopeView window is positioned in 
the middle of a 3X larger data set. So, for each click of the Zoom Out function, the time 
displayed on the window is three times longer.

 Figure 5-12: The ScopeView right-click menu.

Table 
Functions 

These functions are available in both the Analysis and ScopeView windows.

V1, V2, T1, T2, 
V2-V1, T2-T1

This group of functions simply reports the values in time and voltage for the data points inter-
sected by each of the two cursors in the Analysis or ScopeView window. The difference in time 
or the difference in voltage (or calibrated Y-value) can also be reported.

Max, Min, Mean, 
Max-Min

For this group of functions, all data points between the cursors are examined. The maximum, 
the minimum, or the mean value in the data set are reported. The difference between the 
maximum and minimum value can also be reported.

Area, Integral, 
and 
ABS_Integral

All the integral and area functions are calculated as integrals. The Area function uses the line 
between V1 and V2 as the zero baseline, and then calculates the integral. The Area function 
gives more control over which segments of a waveform are included in the integral. 

For the Integral calculation, zero Volts (or zero calculated Y-value) is used as the zero 
reference for the integral. Values above zero add to the Integral, and values below the zero-line 
subtract from the Integral.

The ABS_Integral is very much like the Integral, except that the program takes the absolute 
value of the raw data before performing the integral operation.
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dv1/dt, dv2/dt, 
max dv/dt, Min 
dv/dt, Avg dv/dt

The functions in this group report first derivatives. The dv1/dt and the dv2/dt are the deriva-
tives at V1 and V2, respectively. These points are the intercepts of Cursors 1 and 2 with the 
data of the selected channel. Max dv/dt finds the largest dv/dt values for all of the data points 
between the two cursors. Min dv/dt looks for the smallest dv/dt values for all of the data points 
between the two cursors. The Avg dv/dt finds the slope of the line of best fit for all the data 
points between the cursors.

Avg Max, Avg 
Min, Avg Max-
Min, Avg Mean, 
Avg Period, Avg 
Freq.

These functions determine the mean or average (Avg) value of parameters: Maximum, 
Minimum, Mean, Max-Min, Period, Frequency taken from periodic data displayed in the 
Analysis or ScopeView window. LabScribe uses Threshold set in the Preferences dialogue 
window for determining the cycles. When the cursors are placed around a section of cyclic data, 
the selected function calculates and displays the average of the designated parameter from the 
selected data. For example, if the cursors are placed around five successive ECG cycles, the 
Avg_Max function will calculate the average amplitude of the five R waves in the selected data, 
assuming the R waves are the largest amplitudes in the data file. The algorithms used in these 
functions are the same as the ones employed in the off-line functions.

Copy, Export, 
and Print 
Analysis and 
ScopeView 
Windows

To copy the view of data displayed in the Analysis or the ScopeView window, use the Copy 
command in the Edit menu. The image can be pasted into any program (including the Journal) 
that supports the clipboard. 

To export the data viewed, use the Export command in the File menu. Select the format of the 
file from the list at the bottom of the Export File window.

To print the data viewed, use the Print command in the File menu. The print range, which is 
either the selection in the Analysis window or all the data, can be selected in the Print window.

Analyses of the Third Kind: Redisplayed Data
As covered in the display section of this manual, data is recorded only into the Main window. 

Main window displays are linear or in series, meaning that Y-value parameters are recorded with 
respect to time.

Data recorded in a linear manner can be redisplayed in a format that is different than the 
standard Y-T plot. Currently, LabScribe v1.8 supports XY plots and FFT. A host of measure-
ments, like the ones available in the Second Kind Analyses, can be made from each type of 
redisplayed data window.

XY Plot In an XY plot, the Y-values from one channel in the Main window are plotted against the Y-
values from another Main window channel. The resulting XY plot is dramatically different from a 
linear plot of data against time. 

XY View 
Window 
Components

Display 
Channels List

Located to the left of the linear display area, two drop-down menus allow the user to select 
which channel’s Y-values will be chosen for the Y and X axes of the XY plot.
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Table Functions 
List

The functions selected in the Table Functions list determine the calculations performed on 
the data points between the two cursors in the XY plot display. The results of the selected 
calculations are displayed in the Calculated Value Display area at the top of the XY View 
window. 

Right-Click 
Menu in the XY 
Plot

Right-click in the display area of the XY View window to bring up a menu like the one in 
Figure 5-13 on page 67. Selecting Add Title to Journal sends the names of the analyses 
(calculations) being performed, and displayed at the top of the XY View window, to the Journal. 
Selecting Add Data to Journal sends the calculated values for the analyses to the Journal. The 
right-click menu also gives the user the option to Zoom In or Zoom Out to refine the selection 
of linear data only. The Zoom In function will expand the area between the cursors to full 
screen. When the Zoom Out function is used, the original screen of the Analysis window is 
positioned in the middle of a 2X larger data set. So, for each click of the Zoom Out function, the 
time displayed on the window is two times longer.

 Figure 5-13: The XY View window right-click menu.

Table 
Functions 

Title,Y1, Y2, X1, 
X2, Y2-Y1,X2-X1, 
Max_y, Min_Y, 
Mean_Y, Max_X, 
Min_X, Mean_X, 
Length

This group of functions simply reports the values in time and voltage for the data points inter-
sected by each of the two cursors in the XY View window. As the cursors are moved in the linear 
data plots, data points in the XY plot are highlighted. The Minimum, Maximum, Mean, or 
Difference functions apply to data in the range of data. Length refers to the length of the line 
segment identified between the highlighted data points.

Slope, dY1/dx, 
dY2/dx, Max_dY/
dx,Min_dY/dx, 
Mean_dY/dx, 
Max-Min

For this group of functions, all data points between the cursors are examined. The Maximum, 
the Minimum, or the Mean value of the slope in the data set are reported. The slope at each of 
the highlighted points in the XY plot is also reported.

Area_wrt_Ymin, 
Area_wrt_zero, 
Area_wrt_Y1, 
Loop_Open, 
Loop_closed

The Area functions are integrals which can use several points as the zero baseline. 
These functions have the abbreviation “wrt,” which means “with respect to”. So, the 
Area_wrt_Ymin function returns the area between the plotted curve and an imaginary horizontal 
line intersecting the minimum Y-value. Similarly, Area_wrt_zero uses a horizontal line at zero 
for the area calculation, and Area_wrt_Y1 uses the value at the minimum Y as the reference 
line. Each of these areas returns a partial area of the plot. You may need to use several areas to 
capture the entire area of the plot. 
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The Loop functions assume that the XY plot is a loop, The area enclosed by the loop is 
returned by the Loop_Closed function. The Loop_Open function closes a nearly complete loop 
with a line. This function returns the area enclosed by the loop

Copy, Export, 
and Print XY 
View Window

To copy the view of the data displayed in the XY View window, use the Copy command in the 
Edit menu. The image can be pasted into any program (including the Journal) that supports the 
clipboard. 

To export the data viewed, use the Export command in the File menu. Select the format of the 
file from the list at the bottom of the Export File window.

To print the data viewed, use the Print command in the File menu. The print range, which is 
either the selection in the XY View window or all the data, can be selected in the Print window

FFT FFT is short for Fast Fourier Transform, a mathematical operation that displays recorded data 
as the relative amplitudes of the frequency components that make up the recorded signal. FFT 
plots have Frequency on the X-axis and the Power (amplitude) contained in each frequency on 
the Y-axis. FFT is used to determine the relative strengths of frequency components in a raw 
signal. For example, in the EEG studies, the Alpha band is frequently mentioned. Alpha waves 
are EEG signals with frequencies between 8 and 13 Hz. If a FFT is performed on an EEG 
recording that has a high number of Alpha waves, the FFT will show a spike or a higher 
amplitude (Power) at the frequencies in the Alpha band. 

The LabScribe software can perform Fast Fourier Transforms on selected pieces of recorded 
data in the FFT window. Like other analysis windows (Analysis, ScopeView, XY View), the data 
used in the FFT is selected from the Main window by using cursors to bracket the data region of 
interest. Then, the FFT window is called either from the Windows menu or by clicking the FFT 
icon on the toolbar at the top of the Main window. The selected data is moved to the Linear 
Display area in the FFT window, where adjustments can be made which optimize the size of the 
FFT plot. 

To insure problem-free operation of the FFT function, there are a couple of rules to keep in 
mind:

1. The mathematical underpinnings of digital sampling, which makes the LabScribe software 
work, begin with a criteria known as the Nyquist Sampling Theorem. Harry Nyquist showed that the 
SAMPLING RATE MUST BE AT LEAST TWICE THE HIGHEST FREQUENCY IN THE SAMPLE to recon-
struct the original signal and capture its fundamental frequency. 

 The converse of this rule is that the FASTEST FREQUENCY THAT CAN BE RELIABLY 
RECORDED IS A HALF OF THE SAMPLING RATE. If a recording was made at 1000 samples 
per second, the maximum frequency that could be recorded reliably would be 500Hz. If a 
recording was made at 100 samples per second, the maximum frequency that could be recorded 
reliably would be 50Hz. When a FFT is performed on data recorded with LabScribe, the program 
sets the X-axis to a scale from 0Hz (DC) to a frequency that is a half of the sampling rate. A 
region of the scale can be expanded by using the cursors and the functions of the right-click 
menu, but frequencies greater than half the sampling rate cannot be viewed.

2. To make a FFT work, the transform must operate on a SPECIFIC NUMBER OF DATA 
POINTS. The number of data points used in the FFT is algorithm dependent. The LabScribe 
program indicates the location of the best selection of FFT data on the linear display section of 
the FFT window by using a gray line, in addition to the two cursors used to select the data used 
in the FFT. Move the cursor as close to the suggested point as possible. If it is not possible to 
make the selection reach to the suggested end point, LabScribe will fill in the remaining data 
points with zeros so the frequency content of the data that you DID select will not be affected. 
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As stated in the first rule that governs FFT functions, LabScribe sets the X-axis limits in the 
FFT window according to sample rate. Likewise, the number of data points used in the FFT 
calculation sets the resolution of the X-axis range. If more data points are used, the available 
Frequency Resolution will be greater. Frequency Resolution is set from the drop-down menu 
in the left hand margin of the FFT window. Resolution choices are limited to 100Hz, 10 Hz, 1 Hz 
and 0.1 Hz. If the FFT cannot be displayed with the required frequency resolution, more data 
points need to be used to make the calculation.

Moving and 
manipulating 
data in the FFT 
window

As with other analysis functions handled by the LabScribe program, it is necessary to select 
the data to be operated upon by the program. The Display Time controls are used to get the 
data of interest onto a single screen. Then, the data to be analyzed is selected by using the 
Dual Cursors to bracket the data as it is displayed in the Main window. Finally, the selected 
data is moved to the FFT window by clicking the FFT icon on the LabScribe toolbar or by 
selecting FFT from the Windows menu.

Once the primary data set is moved to the FFT window, the Dual Cursors on the linear graph 
of the raw data (above the actual FFT display area) can be used to fine-tune the data selection. 
Only the data between the cursors in the linear graph is actually used in the calculation. The 
data displayed on the linear graph and available for the transform can be changed using the 
Display Time icons on the FFT window or the scroll bar under the linear graph. Right-click on 
the line graph to open a menu with Zoom In and Zoom Out functions which can also be used to 
increase or decrease the amount of raw data that can be selected for the FFT. As mentioned, 
the LabScribe program suggests the end point for the data selection with a gray line. The 
second cursor used for data selection should be as close to the gray mark as possible.

The FFT plot of the selected data is displayed in the area below the linear graph of the raw 
data. The FFT display area has its own right-click menu with the Zoom In and Zoom Out 
functions and set of Dual Cursors. These features can be used to expand or contract the area 
of the FFT graph between the cursors. This set of Dual Cursors also reports the values for the 
selected Table Functions listed to the left side of the FFT window. The values and the titles, 
which are listed in the Calculated Value Display area at the top of the window, can be copied to 
the Journal by using the functions in the right-click menu for the FFT display area. 

FFT Window 
Components

Display Channel 
List

Located to the left of the linear display area, this drop-down menu allows the user to select the 
channel to be used in the FFT plot.

Table Functions 
List

The calculations to be performed on the region of the FFT plot between the Dual Cursors are 
selected from the Table Functions list to the left of the FFT display area. The results of the 
selected calculations are displayed in the Calculated Value Display area at the top of the FFT 
window. 

Right-Click 
Menu in the FFT 
Plot

Right-click in the FFT display area to bring up a menu like the one in Figure 5-14 on page 70. 
Selecting Add Title to Journal sends the names of the analyses (calculations) being performed, 
and displayed in the Calculated Value Display area at the top of the FFT window, to the 
Journal. Selecting Add Data to Journal sends the values for these calculations to the Journal. 
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This right-click menu also has Zoom In or Zoom Out functions which allow the user to refine 
display of the FFT plot. As explained in other analyses, the cursors in this plot can be used to 
determine the portions of the data to be expanded to full screen. 

 Figure 5-14: The FFT window right-click menu.

Table 
Functions 

Title, 
Power@Cur1, 
Power@Cur2, 
Freq1, Freq2, 
Power Ratio

This group of functions simply reports the Power and Frequency values at Cursor 1 and 
Cursor 2 in the FFT plot. The Power Ratio returns a value equal to Power@Cur1/ 
Power@Cur2. 

Copy, Export, 
and Print FFT 
Windows

Use the Copy command in the Edit menu to copy the view of data displayed in the FFT 
window. This image can be pasted into any program, (including the Journal) that supports the 
clipboard. 

To export the data viewed, use the Export command in the File menu. Select the format of the 
exported file from the list at the bottom of the Export File window.

To print the data viewed, use the Print command in the File menu. The print range, which is 
either the selection in the FFT window or all the data, can be selected in the Print window

Analyses of the Fourth Kind: Detected Data Conditions
LabScribe software can be used to identify Regions Of Interest (ROI) in recorded data. The 

identified data points can be sent to either the Journal or the Marks window, where they can be 
used to either build a report or be exported. While identifying data does not constitute an 
analysis per se, the detection of specific data ALWAYS precedes analysis. For example, to 
measure changes in Left Ventricular End Diastolic Pressure (LVEDP) over time, the LVEDP 
points need to be located in the field of blood pressure data and the corresponding values need 
to be recorded. The statistical manipulation of the recorded LVEDP values is classified as 
analysis; but, the first critical step in the “analysis” was the extraction of the relevant data points 
or regions of interest from the complete data. The events (data points or regions of interest) that 
can be detected by the LabScribe program are classified into two categories: General and 
Specific.
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General 
Events

General events can be located easily through the Find or the Auto Find dialogue windows.

Find Dialogue 
Window

The Find dialogue window is accessed by selecting Find from the Tools menu. The Find 
function is only available on the Analysis or the ScopeView window. Therefore, to manipulate 
data with this function, data must be captured from the Main window and placed in either of 
those two windows. Data points of interest can be identified using stock commands from the 
Find dialogue window. These commands can move cursors to: the Previous or Next Maximum; 
the Previous or Next Minimum; Data Above or Below a certain amplitude; data at a specific 
Mark with a particular STRING in a comment; data at an Old or New Cursor position; and more. 
The calculations to be performed on the selected data points, or on the data between the points, 
are chosen from the Table Functions list before the Find dialogue window is opened. 

The first step in the Find function is the selection of the Cursor 1 Position from the box to the 
right of this label. The next step in the Find function is the selection of Cursor 2 Position from 
the box to the right of this label. Once the source of the data is selected and the Find routine is 
completed, it can be saved by clicking the Save button on the Find dialogue window. The 
named routine is saved in the Auto Find folder as an .iwa file. When the Find dialogue window 
is open, saved routines can be recalled by clicking on the Load button.

Find Example As an example, the Find function could be used to determine the time (T2-T1) between two 
events. Occasionally, R waves in an ECG have significantly higher amplitudes than the other R 
waves in the same recording. The Find function could be used to measure the time between 
adjacent supranormal R waves. The process would include:

• Transferring the data of interest from the Main window to the Analysis window. 

• Selecting the calculations ( V1, V2, V2-V1, T2-T1) to be performed on the data from the Table Functions 
list. 

• Placing one of the Dual Cursors on a supranormal R wave on the left side of the Analysis window.

• Pulling down the Tools menu and selecting the Find function.

• Programming the cursor positions. To find the next supranormal R wave in the data, the Cursor 1 
Position is set equal to Old Cursor 1 (which is already on a supranormal R wave). The Cursor 2 Position 
is set to Data Above, and the data channel is selected. The threshold amplitude, above which the Find 
function will stop, is entered into the box below the label, Cursor 2 Position. Then, the Find routine is 
saved.

• Clicking the Find button to place the cursors and to display the values for the selected Table Functions 
at the top of the Analysis window. 

• Copying values and their headings to the Journal via the Add Title to Jrnl and Add Data to Jrnl 
functions in the right-click menu of the Analysis window.

Auto Find 
Dialogue 
Window

The Auto Find dialogue window (Figure 5-15 on page 72) is like the Find window. It is also 
accessible from the Tools menu, and works only from the Analysis or ScopeView window. 
However, the Auto Find function can be programmed to find multiple data points with the same 
parameters within a data selection. The values at those points can be used for Second Kind 
Analyses. Then, the results on these analyses can be written to the Journal, automatically. 

The Auto Find function can find the same types of data points found with the Find function, 
like: Next Maximum, Previous Minimum, Data Above a given value, the next Mark containing a 
particular alpha-numeric STRING, and more. Like Find routines, Auto Find routines may be 
constructed from the various parameters available and saved in the Auto Find folder. For 
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periodic functions, maximum values, and minimum values, LabScribe uses the threshold values 
set for Periodic data on the Functions page in the Preferences dialogue window for the Main 
window. Just like other measurements of periodic data, the data must be scaled properly, which 
can be accomplished in most cases by clicking the AutoScale button in the Main window.

Auto Find 
Example

As an example, the Auto Find routine can be used to place cursors on all the R waves in an 
ECG record and to measure the period (T2-T1) of each beat. The easiest way to begin the Auto 
Find routine is to manually place the cursors on the two successive R waves at the beginning of 
the record. When selecting the commands to use in this routine, the user should ask 
themselves: ” Where are the next two data points that are needed for measuring the next period 
(T2-T1)?” The answer is that the first data point in the next period is the second R wave from the 
preceding period; and, the second R wave in the next period is the next maximum value or R 
wave in succession. Therefore, to make accurate measurements on the next period, the Auto 
Find window is programmed to set the Cursor 1 Position to be Old Cursor 2, and the Cursor 2 
Position to be the Next Max. 

After the number of repetitions specified or the specified end of the Auto Find routine is 
reached, the Auto Find routine can be saved by clicking Save on the dialogue window. The 
named Auto Find routines are saved as .iwa files, and they can be called by clicking on the 
Load button in the dialogue window.

 Figure 5-15: The Auto Find dialogue window.

Specific 
Events

The detection of Specific events within a recording requires the use of an algorithm to find the 
point or region of interest (ROI). The LVEDP, the R in an ECG, and the P wave in an ECG are 
good examples of Specific events. Detection of these data points requires a defined software 
routine that resides in the LabScribe program. The routines are accessible by selecting Auto 
Mark from the Tools menu and the name of the specific event from the Auto Mark pull-down 
menu. When the detection routine is run on the selected data, the software puts Marks on the 
data at the detected points. The automatic placement of Marks on the data accomplishes two 
things; first, it identifies the data points that need to be manipulated; second, it provides the 
user with visual cues to confirm that the software did the job of detecting the correct points. 
Based on the instructions given to LabScribe, the detected data can be exported as text or 
loaded into a script. 
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In LabScribe V1.8, there are Auto Mark functions available to detect: the QRS wave compo-
nents of the ECG; the LVEDP; Arterial Pressures; Maximal Response; and Peak Detection.

For example, if the Auto Mark detector is used to locate the R waves in an ECG, the QRS 
function is selected from the Auto Mark submenu on the Tools menu. A window known as the 
AutoMark QRS Dialog appears on the screen. It contains a display of the data to be used with 
the marking routine. On this window, selections must be made for the Data Channel that is the 
source of the recording being marked, the Maximum Heart Rate (BPM) in the data of interest, 
and the Start and Stop points for marking the data of interest. 

The Start and Stop points could be the beginning and the end of the data file (Doc.), respec-
tively. They could also be any Mark on the data file. Since Marks can be placed on the data 
after the recording, it is possible to place and use Marks that are on the margins of the data of 
interest. To assist in R wave detection, a threshold level must be set on the data. 

Finally, press Preview and close the AutoMark QRS Dialog window by clicking OK. Each R 
wave in the selected section of data will be marked with a Text Mark. These marks can be 
viewed and edited in the Marks window. The Marks window is organized so that the marks can 
be sorted by Time (ascending or descending), Channel, or by Content by clicking on the title of 
the column in the Marks table. Individual comments, or ranges of comments, may be selected or 
deselected using the SHIFT and CONTROL keys. Appropriate collections of selected comments 
can be exported or deleted.

Analysis of the Fifth Kind: Things Not Possible with 1st, 2nd, 
3rd, or 4th Kind of Analyses

It is impossible to include all of the possible analyses and plotting capabilities required for 
biological research in a single program. We provide, what we believe to be, useful tools for 
completing the most common kinds of analyses. For circumstances where the built-in analysis 
tools fall short of the user’s requirements, LabScribe has a Script function. A script is a 
program, written in any of the languages supported by LabScribe, that can perform a series of 
calculations on selected data. Once created, a script can be placed in the Scripts folder located 
in the LabScribe folder. The script will then appear as a menu item in the LabScribe Scripting 
menu. When selected, the script takes the selected range of recorded data, saves the data in a 
format compatible with the scripting language, loads the scripting program, and then executes 
the script on the saved data. The scripting programs supported by LabScribe are listed below. 
For example, we have created a script in Python, which operates on the R-R intervals of the 
ECG, which are detected by an Auto Mark function in the Tools menu. Then, the R-R script 
computes and displays a tachogram, plots Delta R-R histograms, and determines values for 
statistics, such as mean, mode, and standard deviation. 

Writing 
Scripts

LabScribe has a special folder called Scripts located in the LabScribe folder. Any scripting 
files or executables placed in this folder will be included in the Scripting menu when LabScribe 
is launched.

Scripts can be run from the Main, Analysis, or ScopeView windows in the LabScribe 
program. Different data is presented to the script depending on which window is used to call the 
script. 

The Default Export File Format, for exporting the data that the script will use, is set on the 
Advanced page of the Preferences dialogue window. The default file format is .mat, or the 
Matlab File format. For information about the MatLab and DADiSP file formats, refer to the 
Export section of this manual.
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Scripts in the 
Main Window  

When a script is run from the Main window, LabScribe saves the complete data file in the 
Scripts folder as either input.mat (Matlab) or inputXX.dat (DADiSP). In DADiSP, each block is 
numbered as it is saved XX, starting with 00. When LabScribe calls the script file, the Windows 
operating system opens the script file in the program associated with it. For example, a Python 
script should open in the Python program, and a MatLab script will open in the MatLab program 
and so on. Scripts should be set up to open and analyze data files with the names as described. 

Scripts in the 
Analysis Window 
 

When a script is run from the Analysis window, LabScribe saves the data in the Analysis 
window display in the Scripts folder as either input.mat (Matlab) or input.dat (DADiSP). When 
LabScribe calls the script file, the Windows operating system opens the script file in the program 
associated with it. For example, a Python script should open in the Python program, and a 
MatLab script will open in the MatLab program and so on. Scripts should be set up to open and 
analyze data files with the names as described. 

Scripts in the 
ScopeView 
Window  

When a script is run from the ScopeView window, LabScribe saves the data in the 
ScopeView window display in the Scripts folder as either input.mat (Matlab) or input.dat 
(DADiSP). When LabScribe calls the script file, the Windows operating system opens the script 
file in the program associated with it. For example, a Python script should open in the Python 
program, and a MatLab script will open in the MatLab program and so on. Scripts should be set 
up to open and analyze data files with the names as described. 
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Chapter 6: Input and Output 

Stimulator
The Stimulator page in the Preferences dialogue box controls the Digital-to-Analog Converter 

or DAC of the iWorx hardware. It can be reached by selecting Preferences from the Edit menu. 
Four modes of output are available from this dialogue window: Pulse, Trains, Constant 
(voltage), and Step.

Trains and Step protocols are available only on the iWorx 114/214/118. The iWorx 118 has 
two DAC’s, each can be controlled independently of the other.

The stimulator feature sends the DAC output to the outside world. Using controls described 
below, output protocols can be built from “square wave” components that are listed on the 
Simulator page of the Preferences dialogue window. The available output range of the stimu-
lator is ±5V (±10V for iWorx 118).

Pulse 
Protocols

 Figure 6-1: The parameter boxes on the Stimulator page of the Preferences dialogue window.

In order to understand how protocols are created, it is necessary to define the terms used on 
the Stimulator page of the Preferences dialogue window:

Delay: This is the time between the beginning of the recording, at the clicking of the Start 
button, and the first pulse. Delay is adjustable between 0 and 650ms (6500 ms for iWorx 118).

Amplitude: This is the height or voltage of the pulse or wave being generated. The amplitude 
programmed from the Preferences window will be the same for all pulses leaving the stimulus 
output unless the amplitude is changed manually from the Preferences window or the Stimu-
lator Control Panel, or automatically from a programmed sequence (more later). 

Number of Pulses: The total number of pulses that can be sent from the stimulator output 
after the Start button is clicked.

Pulse Width: The pulse is the basic unit of an output protocol and it has two basic dimen-
sions, amplitude, as described above, and length. The length of the pulse is also called pulse 
width or pulse duration. The pulse duration is adjustable between 0.1ms and the period of the 
pulse (as programmed by the Pulse Frequency).

Pulse Frequency: This is the number of programmed pulses that are delivered in one second 
period of time. Pulse frequency is adjustable between 0.1Hz and 5000Hz. The maximum 
frequency that can be set is dependent on the pulse duration. In the case of the iWorx 104/204, 
the frequency is also dependent on the sampling rate. Remember that the period (P) is the 
inverse of the frequency (F), or P = 1/F.
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Holding Potential: This is a voltage between + and -5V that can be programmed to shift the 
resting voltage of an excitable tissue (like a nerve). It is also known as a holding voltage 
because it can be used to hyperpolarize the membrane potential of an excitable tissue and 
prevent it from depolarizing or “firing”.

Building Output 
Protocols in 
Pulse Mode

To record stimulus pulses like the examples that follow, the stimulator output of an iWorx unit 
can be connected to one of its own BNC inputs. On the iWorx 104 and 118, this is easily accom-
plished by using a BNC-BNC cable. However, the stimulator outputs of the iWorx 114, 214, and 
204 units are three color-coded banana jacks; so, a Double Banana-BNC adapter or cable is 
needed to connect two of the banana jacks to one of the BNC inputs. To record positive pulses, 
connect the adapter to the positive (red) and ground (green) banana jacks; to record negative 
pulses, connect the adapter to the negative (black) and ground (green) banana jacks. Double-
Banana adapters have a flag or bump on one side that indicates that side should be attached to 
the ground jack.

Warning: Never connect both the positive (red) and the negative (black) banana outputs 
of a 114, 214, or 204 unit to its own inputs at the same time, as this causes a short circuit 
that could damage the amplifier. These red and black outputs can be connected to other 
devices (nerve chambers, stimulating electrodes, and more) at the same time, but not to 
its own inputs at the same time.

An Example of 
Continuous 
Pulses

1 To construct and record some examples of stimulus pulses, select Preferences from the Edit menu. On 
the Channels page of the Preferences dialogue window set a channel that has a BNC input to 
record at 10,000 samples/sec and display 0.5 second on the screen (Figure 6-2 on page 76). 

 Figure 6-2: Channels page of the Preferences dialogue window set for the pulse mode example.

2 Go to the Stimulator page of the Preferences dialogue window; select Pulses from the box in 
the upper left corner of the page.

3 Enter the following values into the appropriate boxes on the Stimulator page:

Delay 100msec (an arbitrary value)
Amplitude 1V 
Number of Pulses 0 (for continuous)
Pulse Width 5ms
Pulse Frequency 100 Hz

These settings will create a protocol that delivers continuous square waves with 1V amplitude 
and 100Hz frequency. 
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4 Press the Start button. The DAC will wait 100 milliseconds (the Delay value entered) and begin to 
deliver 5ms pulses at the rate of 100 pulses per second. Each pulse will be 1V high. These pulse 
parameters can be adjusted in any way with one exception: the pulse width cannot be longer than the 
inverse of the frequency (or the period). In this example, the 100Hz square wave delivers 100 events or 
pulses every second. Therefore, each single event or pulse must occur in 1/100th of a second, which is 
a 10ms period. In this example, the pulse width cannot be longer than the period of 10ms, or the pulse 
will overlap the next pulse. The percentage of the period occupied by the pulse width is known as the 
duty cycle and refers to the amount of time the output amplifiers are active.

An Example of a 
Burst of Pulses

Use the settings listed for the example of continuous pulses to produce a short burst of pulses, 
with one exception. Set the Number of Pulses to a number other than zero. If the number 10 is 
entered in this box, the output from the DAC would wait the 100 millisecond delay from the Start 
signal, deliver its 100Hz square wave of 5ms by 1V pulses as before, but stop when 10 pulses 
had been delivered. A graphical representation of the two examples above is pictured in Figure 
6-3 on page 77.

 Figure 6-3: Continuous (top) and burst (bottom) of pulses that are the same amplitude, 
width, and frequency.

Train 
Protocol

The Train Protocol is Available Only on the iWorx 114/214/118.

A train of pulses is more properly called a burst of pulses. Trains contain a specified Number 
of Pulses; occur a specified number of times, Number of Trains; and, occur at regular 
intervals, InterTrain Duration. The train protocol is an extension of the pulse protocol and it is 
essential to be familiar with the pulse protocol to use the train protocol. 

The terms used on the Stimulator page of the Preferences dialogue window for configuring 
trains of pulses, include:

Delay: This is the time between the beginning of the recording, at the clicking of the Start 
button, and the first pulse. Delay is adjustable between 0 and 1,000 seconds.

Amplitude: This is the height or voltage of the pulse or wave being generated. The amplitude 
programmed from the Preference window will be the same for all pulses leaving the stimulus 
output unless the amplitude is changed manually from the Preference window or the Stimulator 
Control Panel, or automatically from a programmed sequence (more later).

Number of Pulses: This is the number of pulses in one train.

Pulse Width: The pulse is the basic unit of an output protocol and it has two basic dimen-
sions, amplitude, as described above, and length. The length of the pulse is also called pulse 
width or pulse duration. The pulse duration is adjustable between 0.1ms and the period of the 
pulse (as programmed by the Pulse Frequency).

Pulse Frequency: This is the number of programmed pulses that are delivered in one second 
period of time. Pulse frequency is adjustable between 0.1Hz and 5000Hz. The maximum 
frequency that can be set is dependent on the pulse duration. In the case of the iWorx 104/204, 
the frequency is also dependent on the sampling rate. Remember that the period (P) is the 
inverse of the frequency (F), or P = 1/F.

Continuous output

Burst or Train output
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Number of Trains: Number of Trains 

Inter Train Duration: The length of time between successive trains or bursts.

Holding Potential: This is a voltage between + and -5V that can be programmed to shift the 
resting voltage of an excitable tissue (like a nerve). It is also known as a holding voltage 
because it can be used to hyperpolarize the membrane potential of an excitable tissue and 
prevent it from depolarizing or “firing.”

 Figure 6-4: The parameter boxes on the Stimulator page of the iWorx 114, 
214, or 118 set for Train mode.

Building Output 
Protocols in 
Train Mode

Connect the stimulus outputs to one of its own BNC inputs as described in the section of the 
chapter, Building Output Protocols in Pulse Mode. 

Never connect both the positive (red) and the negative (black) banana outputs of a 114, 
214, or 204 unit to its own inputs at the same time, as this causes a short circuit that 
could damage the amplifier. These red and black outputs can be connected to other 
devices (nerve chambers, stimulating electrodes, and more) at the same time, but not to 
its own inputs at the same time.

In many applications, more than one burst or train of pulses must be delivered. Before the 
parameters of the trains or bursts are specified, the dimensions of the pulses that will fill the 
bursts must be selected. After the pulse is designed, the frequency, duration, and number of 
trains can be programmed.

An Example of 
Pulse Trains

1 To construct and record an example of pulse trains, select Preferences from the Edit menu. On the 
Channels page of the Preferences dialogue window set a channel that has a BNC input to record 
at 10,000 samples/sec and display 0.5 second on the screen (Figure 6-2 on page 76). 

2 Go to the Stimulator page of the Preferences dialogue window; select Trains from the box in 
the upper left corner of the page.

3 Enter the following values into the appropriate boxes on the Stimulator page:

Delay 100msec (an arbitrary value)
Amplitude 1V 
Number of Pulses 10 (10 pulses at 100 Hz = 0.1 sec)
Pulse Width 5ms
Pulse Frequency 100 Hz
Number of Trains 25
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Inter Train Duration 900ms
These settings will create a protocol that delivers: a train of pulses every second; 10 pulses in 

each train with a frequency of 100 Hz; and, all pulses with an amplitude of 1V and a width of 
5msec. Since a train occurs every second and is 100msec long, the time between trains, the 
Inter Train Duration, needs to be 900msec.

4 Press the Start button. The DAC will wait 100 milliseconds (the delay value entered) and begin to 
deliver ten 5ms pulses in a tenth of second. Each pulse will be 1V high. After 900 milliseconds, a 
second burst of ten pulses with the same parameters will occur. These bursts will appear in this manner 
until a total of 25 bursts have occurred. 

5 If you only wanted the train or burst to repeat four times, the number 4 should be entered in the Number 
of Trains box. The completed output protocol should look something like Figure 6-5 on page 79.

 Figure 6-5: Burst of pulses separated by Inter Train Durations.

Constant 
Voltage 
Protocol

Selecting the Constant (voltage) option on the Stimulator page of the Preferences dialogue 
window disables the entry boxes for all stimulus parameters, except Amplitude and Delay. 
When the Start button is clicked, the voltage set on the Stimulator page is delivered to the low 
voltage output of the iWorx unit. The voltage output terminates when the Stop button is pressed.

Step Protocol The Step Protocol is Available Only on the iWorx 114/214/118.

Step mode is used almost exclusively for voltage clamp protocols. In Step mode, the 
amplitude of stimulator output can be increased or decreased in a step-wise manner, and the 
user can specify the following parameters: Delay, Start Amplitude, End Amplitude, Number of 
Steps, Step Width, and Inter Step Width.

Building Output 
Protocols in Step 
Mode

The amplitude of each individual step in the protocol is determined by the LabScribe program 
with the Starting and Ending Amplitudes and the Number of Steps entered on the Stimulator 
page. The equation used to do this calculation is: 

(Start Amplitude - End Amplitude) = Voltage Increment
 Number of Steps

If the user knows the voltage increment needed at each step, the equation can be transposed 
to solve for the Number of Steps required in the protocol and this value can be entered on the 
Stimulator page:

(Start Amplitude - End Amplitude) = Number of Steps.
Voltage Increment

Likewise, if the user knows the previous amplitude and the voltage increment, the succeeding 
amplitude can be calculated:

Previous Amplitude + Voltage Increment = Succeeding Amplitude
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With the starting, ending, and incremental voltages set through preferences, the voltage will 
change in a step wise manner until the ending voltage is reached. The length of the protocol is 
determined by the Step Width and the time between steps, the Inter Step Width.

 Figure 6-6: The parameter boxes on the Stimulator page of the 
iWorx 114, 214, or 118 set for Step mode.

An Example of 
Voltage Steps

1 To construct and record an example of pulses in step mode, select Preferences from the Edit menu. 
On the Channels page of the Preferences dialogue window set a channel that has a BNC input to 
record at 10,000 samples/sec and display 0.5 second on the screen (Figure 6-2 on page 76). 

2 Go to the Stimulator page of the Preferences dialogue window; select Step from the box in the upper 
left corner of the page. 

3 Enter the following values into the appropriate boxes on the Stimulator page:

Delay 0
Starting Amplitude  -1V
Ending Amplitude +1V
Number of Steps 8
Step Width 100 ms
Inter Step Width 0
Holding Potential 0

4 These settings will create a wave form that starts at -1 Volt and climbs to +1Volt in eight steps, each 
step has a voltage increment of 0.25V and 100ms wide.

5 Press the Start button. The resulting wave would be similar to the step-wise elevation of 
output amplitude seen in Figure 6-7 on page 80. 

 Figure 6-7: An example of a continuous step protocol.

6 To create a step protocol where the voltage returns to a baseline value between steps, alter 
the Inter Step Width to a number greater than zero. The resulting wave would be similar to 
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that seen in Figure 6-8 on page 81.

 Figure 6-8: An example of a step protocol punctuated by 
returns to baseline between steps.

7 A Constant voltage protocol can be combined with the Step protocol to have the voltage return to a 
different baseline after the completion of the step sequence. For example, setting the Holding Potential 
in the sample step protocol to 500mV would cause the output amplitude of the stimulator to return to 
500mV at the end of the step sequence. Subsequent firings of the protocol would begin from the new 
baseline of 500mV, drop to the Start Amplitude in the example (-1V), step to the End Amplitude (+1V), 
and then return to the Holding Potential of 500mV.

The 
Stimulator 
Panel 

Selecting the Stimulator Panel item in the View menu (Figure 6-9 on page 81) will place a 
Stimulator Control Panel (Figure 6-10 on page 81) on the Main window, if the stimulator is 
programmed to be in Pulse and Constant modes.

 Figure 6-9: The View menu.

Changes to the pulse amplitude, width, frequency, and number of pulses can be made as 
recording is proceeding. To complete the changes, the Apply button must be clicked.

 Figure 6-10: The Stimulator Control Panel.

Note: The Stimulator preferences dialog will draw whatever protocol you specify. Be sure to examine the 
output representation carefully before closing the dialog to confirm that this is in fact the output that you 
want. If you request junk, the stimulator will deliver exactly what you ask.
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Stimulator 
Display

On iWorx 114/214/118, the stimulator output can be fed to a channel on the LabScribe 
recording window by the hardware. So, it is possible to view the stimulator output on any 
channel without using a cable to connect the output to an input.

Right click on the channel. Select Stimulator Dspl, and then 
Out1 or Out2. Out2 displays the second stimulator output 
(DAC2) and is available only on the iWorx 118. 

Stimulus 
Protocols 
Built with the 
Sequence 
Builder

Experiments are often designed to record the response of a cell (or a tissue) to progressively 
larger or more frequent stimuli. In these cases, parameters of the stimulus are changed before 
each recording of the cell’s response to the next stimulus. The Output Sequence Builder, a 
page in the Preferences dialogue window, can be used to automatically change parameters of 
the stimuli released from the DAC. 

For example, excitable tissues like nerves and muscles are composed of multiple fibers, each 
with a different diameter, conduction velocity, and threshold. Fibers with higher thresholds 
require a larger stimuli to evoke their action potentials. Increasing the amplitude of the stimulus 
sent to the excitable tissue will cause more fibers in the tissue to fire. This is known as 
recruitment and is measured as an increase in the amplitude of the tissue’s compound action 
potential. 

In Scope mode, the Output Sequence Builder and other pages (Channels, Sampling, 
Stimulator) in the Preferences dialogue window can be used to record each response of the 
excitable tissue to a stimulus and automatically increase the amplitude of the stimulus between 
each trial.

Channels Page To construct an example of an Output Sequence designed to control the DAC and to record in 
Scope mode, select Preferences from the Edit menu. On the Channels page of the Preferences 
dialogue window set:

Sampling Speed 20000
Display Time 0.030 sec
Number of Channels 1
Channel Title Stimulus
Mode BNC
Function Stem 1

 Figure 6-11: Channels page of the Preferences dialogue window set for testing an Output Sequence.
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Sampling Page On the Sampling page, select Scope as the recording mode; change Repetitive to Multiple 
Sweeps; and set the number of Sweeps to 10.

 Figure 6-12: Sampling page of the Preferences dialogue window set for testing an Output Sequence.

 Figure 6-13: Stimulator page of the Preferences dialogue window set for testing an Output Sequence.
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Stimulator Page On the Stimulator page, select Pulses as the stimulating mode and set the parameters.

• Toolbar Steps

Freq (Hz) = 1; Amp (V) = 0.05; Time (ms) = 0.1.

• Initial Parameters

Delay 5 ms

Amplitude 0.25 V

Number of Pulses 1

Pulse Width 0.1 ms

Pulse Frequency 100 Hz

Holding Voltage 0 V

Output Sequence 
Page

 Figure 6-14: Output sequences page of the Preferences dialogue window.

1 On the Output Sequences page, add a test sequence to the list of current sequences. Type the name 
of the test sequence in the edit box above the Add and Rename buttons. 

2 Select the name of the new test output sequence from the list next to the label, Current Sequence. 
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3 Select the state entitled Inc Amp Stim 1 from the list of states on the left side of the page. 

4 Click on the button Add State to Sequence to add the state to the test sequence. 

5 Click OK at the bottom of the page.

6 Return to the Main window; select the test sequence from OutSeq list to the right of the LabScribe 
toolbar. Click the OutSeq button. The LabScribe program generates, displays, and records the ten 
progressively larger stimulus pulses on ten successive Scope sweeps.

7 Click on the ScopeView icon in the LabScribe toolbar to view the sweeps recorded for each stimulus 
amplitude.

Digital Outputs
The iWorx 118 has up to eight Digital Outputs in two banks. BNC’s 5 -8 can be configured as 

Digital Inputs or as Digital Outputs. Each digital output can be controlled independently.

Digital states For each digital output there are two states, On and Off. So for 8 digital outputs we have 16 
states. A few more states are predefined in LabScribe such as 

1)All off: turns all digital outputs off

2)Stim1 Fire: Fires stimulator 1 (DAC 1)

3)Stim2 Fire: Fires stimulator 2 (DAC 2)

Naming States Each digital state can be named. To name a digital state, select the state. Type the new name 
of the state in the edit box under the label States. Put a check next to Mark Record if you want 
a mark to be placed on the record when the digital state is fired. Click Edit to save the changes 
to the state. For example, in the figure below, DO2 on has been labelled as Pump On and set to 
place a mark in the record when it is fired.

Sequences Digital states can be grouped together in Sequences. A Sequence allows timed execution of 
digital states. 

Creating 
Sequences

To create a Sequence, type the name of the sequence in the edit box under the label 
Sequences, and click Add. 

Editing a 
Sequence

Select the sequence to be edited in the Current Sequence drop-down box. To add a digital 
state to the sequence, select the digital state from the list on the left side of the window, and 
click Add State to Sequence. To remove a state from the sequence, select the state in the 
sequence and click Remove State from Sequence. To have the iWorx device wait for a 
specified period of time between different digital states, type a time (in seconds) in the edit box 
next to the Wait button, and click Wait to insert the waiting period into the sequence. 

The timing for the digital inputs is handled by the computer and since Windows is not a real-
time operating system, there is an inherent lag in the processing of events. The digital output 
timing should be within 1 second. To set more than one state at the same time add all the states 
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you want to set simultaneously to the sequence before setting wait. The LabScribe program will 
“OR” all the states and execute them when it reaches the wait statement or the end of the 
sequence. To continuously repeat the sequence, select repeat sequence checkbox. The order 
of the states in the sequence can be changed by using the up and the down buttons.

Firing a 
Sequence

When digital sequences are created and the iWorx 118 hardware 
is connected with Labscribe. The Digital Output toolbar is 
enabled. You can turn off or on this toolbar using View->Digital 
Output Bar. The toolbar consists of a drop-down box, that lists all 
the digital output sequences that have been created in the prefer-
ences dialog box. While recording to fire a digital output sequence 

just select it from the drop-down list, or if the sequence was already selected click on the DOut 
button next to the torpedoing box.

Digital Inputs
The iWorx 118 has up to 8 Digital inputs in two banks. BNC’s 5 -8 can be configured as digital 

inputs or as digital outputs. To enable digital inputs, select the Enable Digital Inputs checkbox 
in the Digital I/O page in Preferences.
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Viewing 
Digital Inputs

Once enabled in the Preferences dialog 
box. digital inputs can be viewed on any 
channel either online or offline. To enable 
digital inputs on a channel, right-click on 
the channel and go to Dig. Input. Digital 
inputs can be viewed as one 8-bit word 
(D1-D8) or as a 4-bit word (D1-D4). Digital 
Input 1 and Digital Input 2 are special 
inputs. Digital Input 1 also serves as an 
edge triggered input, which can detect 
pulses as small as 50ns. Digital Input 2 
also doubles as an 8-bit resolution, 
unipolar analog input. It allows the input of 
an analog signal with a range of 0 to +10 
Volts, and resolves it to within approxi-

mately 40 mV. When selected, it acquires at the same speed as the other analog input channels. 
To view this 8-bit analog data select D2_Analog.

Each of the digital inputs can be viewed as a raw data (1-bit) or as a calculation performed on 
the data, such as: 

Frequency: The frequency of digital events

Period: The period of digital events

Time On: The time that the digital input was On, during a period.

Time Off: The time that the digital input was Off, during a period.

Duty Cycle or (Time On/Period) x 100: Gives the percentage of time that the digital input was 
ON during a period.

Count: Counts the number of digital events. When selected shows a dialog box that can be 
used to set the time after which the count should be reset. This is useful for counting the number 
of events over a time interval, like 10 seconds.

There is also a built-in 8-bit counter on D1. The counter counts 
the number of negative-going pulses between samples. This 
counter can be used to detect frequencies greater than the 
sampling speed. 
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Events
As LabScribe acquires data, it is aware of the value of each data point as it happens. It should 

then be possible to "train" the software to watch for values above or below a specified level and 
have LabScribe advise the user when such conditions are met. This feature in LabScribe is 
called an "EVENT.” Events are set up in the events area at the bottom of the ADVANCED tab of 
the PREFERENCES menu. Each channel can have two such events specified.

 Figure 6-15: Controls for the Event programming on the iWorx 114/214/118

LabScribe advises the user that a data condition has been met by firing an output sequence. 

A possible application might be as follows: Suppose we create two sequences in the 
sequences builder: a sequence that turns I/O 1 ON, and another that turns I/O 2 OFF. If we send 
the I/O 1 output line to a valve at the bottom of a reaction chamber, we can open and close the 
valve and release pressure. If we also attach a pressure sensor to the chamber and run its 
conditioned output into channel 1 of the iWorx 118 data acquisition system, LabScribe can then 
follow the pressure in the reaction chamber. We can then create a pair events that will follow the 
pressure on Channel 1 and when the value goes from below 500mmHg to above 600 mmHg 
LabScribe will fire the first sequence that will open the valve and release the pressure. When 
the value on Channel 1 drops from above 500mmHg to below 400 mmHg, LabScribe will fire the 
second sequence and close the valve. When the value of pressure observed on Channel 1 goes 
above 500mmHg, I/O 1 turns on and opens the valve releasing the pressure. When the pressure 
falls below 500 mmHg I/O 1 turns off and the valve closes.
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Chapter 7: Using Settings

The Settings Menu
LabScribe offers users a lot of choices for recording and displaying data. When certain 

choices are used repeatedly, a template, known as a settings file, can be created to reduce the 
time required to program the recording software and the A/D converter.

To understand how to use settings files, two terms need to be defined: settings group and 
settings file. A settings group is actually a simple text document that can contain up to 100 
individual settings files. Each settings file is a collection of settings for performing an exper-
iment and are programmed by users through the Preferences dialogue window from the Edit 
menu. The settings contained in a file include items like: the number and titles of channels in the 
LabScribe windows; the sampling speed; the units conversions; the stimulator settings.

In addition to the hardware and software provided in its teaching kits, iWorx provides 
laboratory manuals with a variety of experiments. To support the use of experiments in the 
manuals, iWorx has created a settings group for each laboratory manual. Each settings group 
contains a settings file for each experiment in the manual. Settings groups are loaded on the 
computer during the installation of the LabScribe recording software. Once a settings group is 
loaded, the settings files within the group can be called from a list on the Settings menu.

Calling A 
Settings File

Before a settings file can be selected and activated, the settings group that 
contains the file must be loaded. To do this, select Load Group from the 
Settings menu (Figure 7-1 on page 89).

 Figure 7-1: The Settings menu.

The Load Settings Group dialogue 
window will appear (Figure 7-2 on page 
89). All the settings groups that are 
available will appear in the list box on 
the left side of this settings group 
dialogue window. Highlight the settings 
group needed, and click the Load button 
to load the selected settings group and 
close the dialogue window. 

 Figure 7-2: The Load Settings Group dialogue window.
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Once a settings group is loaded, all of the settings files 
contained in the group appear by name in the lower bracket of 
the Settings menu (Figure 7-3 on page 90). To select a specific 
settings file, highlight the name of the file and click it. The 
settings associated with the selected file will load into the 
LabScribe program and set parameters for recording and 
displaying data.

For a settings group associated with an iWorx teaching kit, the 
names of the settings files on the list correspond to the names 
of the experiments in the lab manual.

If the iWorx laboratory manuals are installed from the instal-
lation CD as prescribed, each settings file in the settings group 
for a teaching kit is associated with a helper file, which is a 
.pdf copy of the laboratory exercise as it appears in the iWorx 
laboratory manual. 

Users can design their own settings groups and files. They can 
also associate their own setting files with documentation 
(experimental procedures, protocols, instructions, lab 
exercises) of their own design. 

 Figure 7-3: The Settings menu with an expanded settings list.

Creating a 
New Settings 
Group

To create a new settings group. Choose the Load Group command from the Settings menu 
(Figure 7-1 on page 89), type an appropriate group name in the title box at the bottom of the 
Load Settings Group dialogue window (Figure 7-2 on page 89) and press the New button. The 
new settings group name will now appear in the list box on the left of the window.

Editing 
Settings 
Group

The Settings Group currently being used 
can be edited by selecting the Edit Group 
function from the Settings Menu.

 Figure 7-4: The Edit Settings Group dialogue window.
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Adding a New 
Settings to Group

Before adding a new individual settings file to a settings group, configure the LabScribe 
program to do the experiment you want to do. For example, go to the Channels page in the 
Preferences dialogue window and select the number of channels needed, their titles, and any 
on-line Functions that are needed to display or interpret the data. If these settings are going to 
become a settings file in an existing settings group, make sure that group is already loaded 
before proceeding. Next, select the Edit Group function in the Settings menu.

When the Edit Settings Group dialogue window appears, type the name of the new individual 
settings file in the blank area at the top of the dialogue window. Press the Add button. This new 
settings file is now part of the current group, and it will appear at the bottom of the list box (only 
after the Add button is pressed). Click OK to leave the Edit Settings Group window. This new 
settings file will be added to the settings list on the Settings menu when the Edit Settings 
Group dialogue window is closed.

Helper Files Helper files are documents with experimental instructions, diagrams, and illustrations that can 
be linked to settings files and displayed on the computer screen when a settings file is 
selected. On the LabScribe installation CD, iWorx/CB Sciences provides a laboratory manual 
and a settings group for each of its kits. In the installation process, a .pdf copy of each 
individual lab experiment in a manual is linked to the corresponding settings file in the settings 
group for that manual. When the user selects a settings file to do a particular experiment, a .pdf 
copy of the linked helper file (the experimental write-up) opens in Acrobat Reader. The user now 
has a set of instructions, on the computer screen, to follow as they do the experiment.

Users can attach their own helper files to their own settings files. Although, iWorx/CB 
Sciences has chosen to attach .pdf documents to its setting files, any file (HTML, Word Perfect, 
MS Word, etc.) can be linked to a settings file. 

To create a new settings file with an attached helper file, select the Edit Group function in the 
Settings menu. When the Edit Settings Group dialogue window appears, type the name of the 
new individual settings file in the blank area at the top of the dialogue window. Then, use the 
Browse button in the lower right corner of the Edit Settings Group window (Figure 7-4 on page 
90) to locate the helper file on the computer being used. Once the helper file is found using the 
browser, select the file, and click the Open button on the browser window. The path to the 
helper file will appear in the Associated Help File box. Press the Add button. This new settings 
file is now part of the current group, and it will appear at the bottom of the list box (only after the 
Add button is pressed). Click OK to leave the Edit Settings Group window. This new settings 
file will be added to the settings list on the Settings menu when the Edit Settings Group 
dialogue window is closed. If the new settings file is selected from the list, its associated helper 
file will open automatically.

Deleting a 
Setting 

To remove or rename a settings file, select Edit Group from the Settings Menu. In the list box 
on the Edit Settings Group window, highlight the file to be removed or renamed; its name will 
appear in the title field (the box above the list box). Click Remove to delete the selected settings 
file from the settings group. If the file is to be renamed, change the name in the title field, and 
click Rename. Click OK to close the Edit Settings Group dialogue window. The settings file, 
that was removed or renamed, no longer appears in the list under the Settings Menu.

Editing a Setting 
File

An individual settings file may be edited using either of two methods. If the settings file has an 
error or an omission, select the settings file from the list on the Settings Menu. Once the 
settings file is loaded and the computer screen has configured itself according to the commands 
from the settings file, go to the Preferences dialogue window under the Edit Menu on the 
LabScribe Main window. Make the needed changes to the settings file. 
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Then, select Edit Group from the Settings Menu. Once the Edit Settings Group dialogue 
window is open, highlight the name of the setting file that was edited, and click the Remove 
button. This is done because the old name of the settings file needs to be removed from the list 
box before the revised settings file can be renamed and saved. Type the new name of the 
revised settings file in the title box (above the list box). Click the Add button and the new name 
of the revised settings file will be added to the list box. 

Renaming 
Settings

To rename a settings file, pull down the Settings Menu and select Edit Group. From the list 
box in the Edit Settings Group dialogue window, select the settings file to be renamed.Type the 
new name of the settings file in the title box (above the list box). Click Rename.

Appending a 
Settings to this 
Group

Settings files can be appended from one Settings Group to another. First, load the settings 
group that will receive the settings files from the other group. Do this by pulling down the 
Settings Menu, selecting Load Group, and selecting the settings group that will receive the 
transferred settings files. 

Next, to find the settings group that will be donating settings to the first group, pull down the 
Settings Menu again, select Edit Group, and click the Append button in the Edit Settings 
Group window. An Open window appears; this window allows the user to browse the computer 
for the donor settings group. Select the donor group and click the Open button on this window. 
All the settings files from the donor group, and the links to the helper files associated with these 
setting files, are added to the list for the recipient group. Use the Remove and Rename buttons 
to alter the revised list of setting files in the recipient group.

Exporting 
and 
Importing 
Settings

A settings group with its associated helper files can be exported to a folder on the computer. 
or a folder containing a settings group from another computer can be imported.

Settings groups, on a computer where LabScribe is used, can be exported, transferred, and 
imported into LabScribe folder on another computer. To export a settings group, pull down the 
Settings menu and select Load Group. Highlight the name of settings group to be exported on 
the list in the Load Settings Group dialogue window. Click the Export button on this window. 

A Save As window will open. The Save As window can be used to browse for a second 
settings group; or, it can be used to pick a destination folder for the settings group to be 
exported. Once the settings group to be exported is selected by highlighting its name and icon, 
its name will appear in the File Name box on the Save As window. The Save As window can 
now be used to create or to browse for a destination folder where the soon-to-be settings group 
can be stored. Select the folder that will receive this exported settings group, and click the Save 
button. 

Copy the folder with the exported settings group to the other computer. This exported 
settings group can be imported as a whole into the LabScribe program on the recipient computer 
by using the Import function. To use the Import function, pull down the Settings Menu on the 
recipient computer, select Load Group, and click the Import button on the Load Settings 
Group window. An Open window appears and it can be use to browse the recipient computer for 
the imported settings group. Find and select the settings group to be imported, and click the 
Open button. The imported settings group will be added to the list of settings groups in the copy 
of LabScribe on the recipient computer. Individual settings files from the imported settings group 
can be added to another settings group on the recipient computer by using the Append function.
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Chapter 8: Export

Printing
Once you have recorded and analyzed your data, you’ll probably want to create a report or 

other presentation. This can be done in a variety of ways, the easiest of which is to simply print 
the recorded data. The LabScribe software uses a WYSIWYG (What You See Is What You Get) 
printing scheme. That is, the print command will print the forward window exactly as it appears. 
This is particularly important for the Journal and the Analysis window. These windows require 
that the correct segments of data be displayed exactly as you want to print them before they can 
be printed. Call up a print dialog that offers three print options: 

1) Print all

2) Print a selected range of pages

3) Print just the current display.

It is also possible to change the print setup from the print dialogue.

It is important to note that the Main window prints the entire recorded file at the screen time 
selected. In other words, a 60 second data file would print in one page if the screen time were 
set to 60, two pages if screen time was 30 and so on. 

Cutting, Copying and Pasting
LabScribe supports cutting and copying from all windows. Copying is done from any window 

using the Copy command in the Edit menu. Within the LabScribe program, pasting is supported 
only in the Journal. To paste into the Journal, first copy data from either the Main or Analysis 
windows. Open the Journal and go to the Edit menu. Select Paste. Journal images can be 
copied and pasted to other programs for editing.

Saving and Saving As
Once recorded, the LabScribe program can save data in its own binary format using the Save 

or Save As command found in the File menu. These commands work the same as they do in 
every other program written for Windows 95/98/Me/NT or XP. Selecting Save As will create a 
copy of the file on the disk with a new name. LabScribe saves three documents with each file 
saved:

1 The actual raw data, which is held in a file with the.iwd extension (iWorx Document).

2 The Journal file, which carries the same name as the data document, but uses the extension .rtf (Rich 
Text Format). 

3 The settings documents with the extension .iws (iWorx Settings).
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Journal
The Journal is actually very similar to WordPad. Files created and saved from the Journal go 

to the disk in .rtf format allowing them to be opened and edited in any program that supports that 
format. A formatted and edited .rtf file may then be printed in whatever program you are using to 
read it, including the LabScribe software. 

 Figure 8-1: Text and image as displayed in the Journal window.

In addition to images, calculated values from the Analysis window or the ScopeView window 
can be moved to the Journal by calling the Add Data to Journal command in the Tools menu. 
Prior to moving calculated values, it is recommended that the title line from the Analysis 
window be moved by using the Add Titles to Journal command in the Tools menu. Titles and 
data are tab delimited so they can be easily formatted in any word processing program.

By moving pictures and calculated values to the Journal and adding typed comments from the 
keyboard, an entire lab report can be created without ever leaving the LabScribe program. 

Exporting Data
Data can be exported from LabScribe, either as numbers or as pictures, from the Main 

window, the Analysis window, or the ScopeView window. To export data, select Export from 
the File menu, and choose the file’s format, location, and name in the dialogue window.
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Exporting 
pictures

The current display can be exported as a picture in bitmap (.bmp) format or in a portable 
network graphics (.png) format. Png is a high resolution format for images. 

Exporting 
numerical 
data

If data is exported from the Main window, the complete data file is exported, in either Matlab 
or DADiSP formats.

If data is exported from the Analysis or ScopeView windows, then only the data displayed in 
the window is exported.

Data from the Analysis or ScopeView windows can be saved in Text (.txt), Matlab (.mat), 
Axon Text Format (.atf), or DADiSP (.dat) format.
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